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Chapter No 1 

What is Computer? 
 

DEFINITION NO 1: 

Computer is an electronic device which takes some input, process it, and produce output. 

DEFINITION NO 2: 

Electronic machine operating under the control of instructions stored in its own memory 
 Accepts data 
 Manipulates data 
 Produces results 
 Stores results 

 

 

 

 

 

PARTS OF COMPUTER: 

According to above definition we can divide computer functionality in to three main parts 

 Input 

 Output 

 Process 

 

 

 

INPUT  

Input is any data or instructions entered to the computer. Input can be in the form of audio, 
video, graphics and animations and instructions. Instructions can be  

 Programs 

 Commands 

 User response 

INPUT  OUTPUT PROCESS 
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Programs 

Program tells a computer what to do and how to do? These are written instructions in some 
specific language.(languages will be describe future) 

Commands 

Command  causes a program to perform a specific action. Like Ctrl+S for saving a Ms.Word 
Document 

User Response  

 A user response is an action which is or can be done by answering any question from 
computer like You want to save that file? User have two options Yes or No, that is depend on 
the user what to response 

PROCESS 

Computer data processing is any process that uses a computer program to enter data and 
summarize, analyze or otherwise convert data into usable information. The process may be 
automated and run on a computer. It involves recording, analyzing, sorting, summarizing, 
calculating, disseminating and storing data. Because data is most useful when well-presented 
and actually informative, data-processing systems are often referred to as information 
systems. In computer processing is done by CPU (Central Processing Unit) 

OUTPUT  

Output is the data that has been processed in to useful form. The computer takes the input 
from user process it and produced output. Output also can be text, Audio, Video, graphics 
and animations. Output can be in two forms 

 Soft Copy 

 Hard Copy 

Soft Copy: 

When you are writing a document, playing a game, watching a video clip, or reading the 
latest news. Soft copy is what you see on the monitor(Screen). Soft copy is temporary; after 
you have finished with it, there is nothing solid to hold. You can, however, transfer soft copy 
to a disk to transport it 

Hard Copy:  

Hard copy can be touched and carried. Hard copy is usually some form of paper output. It is 
especially helpful if you need to have a colleague look at your work or you need to give your 
work to a supervisor or teacher. 
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COMPONENTS OF COMPUTER 

There are three main Components of computer. 

1. Input devices 
2. CPU 

3. Output Devices 

 

 

 

INFORMATION PROCESS CYCLE 

Computer process data (input) into information (output).A Computer often holds data, 
information, and instruction in storage for future use. 

The series of input, process, output and storage activities as the information process cycle. 

 

 

 

 

 

 

 

 

 

 
 

INPUT 

DEVICES 
OUTPUT 

DEVICES 

CPU 

INPUT   OUTPUTCPU 

STORAGE 

MEDIUM 

DATA   INFORMATION

INSTRUCTION
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WHAT IS DATA? 

 

Definition:      “Raw facts, figures, events and transactions are called data” 

Example: 

 Researchers who conduct market research survey might ask member of the public to 
complete questionnaires about a product or a service. These completed questionnaires 
are data. 

 NADRA prepared CNIC of Pakistanis by collecting data of people who belongs to 
Pakistan. 

 Some candidates want to take admission in university they will fill admission forms. 

Above all are unprocessed and unprepared which is needed to process and work more. 

 

WHY WE NEED DATA 

 Facts, statistics used for reference or analysis.  

 Numbers, characters, symbols, images etc., which can be processed by a computer.  

 Data must be interpreted, by a human or machine, to derive meaning  

 "Data is a representation of information" *  

 

WHAT IS INFORMATION? 

DEFINATION:  

 “Meaning full data is called information” 
 “Processed data is called information” 

 

WHY WE NEED INFORMATION 

 Knowledge derived from study, experience (by the senses), or instruction.  

 Communication of intelligence.  

 "Information is any kind of knowledge that is exchangeable amongst people, about 
things, facts, concepts, etc., in some context."  

 "Information is interpreted data"  
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Detail Example: 

Some candidates want to take admission so they will fill an admission form containing data 
about their selves. When this data is organized and arranged by eligibility criteria and 
admission rules a merit list will be formulated. This merit list is in the form of information of 
certain students which are eligible for admission. 

Data 

 

 

 Process 

  

 

 

 

 

  

 Information 

DATA  INFORMATIONPROCESS 

Name: Ali, Ayesha, Ahmad, Munir 
Marks:10,5,2,8 
 

Merit calculation 
If marks >=5 
candidate is eligible

Merit List 
Sr No Name  Marks 

1 Ali  10 

2 Ayesha  05 

3 Munir  08 



Chapter No 2:  Components of Computer‐Input Devices 

6 
 

 

Chapter No 2 

COMPONENTS OF COMPUTER 

INPUT DEVICES 

 

 

 

 

 

 

WHAT IS INPUT? 

Input is any data or instructions entered to the computer. Input can be in the form of audio, 
video, graphics and animations and instructions 

WHAT ARE INPUT DEVICES? 

 Any hardware component used to enter data, programs, commands, and user responses into 
a computer 

Examples  

 Key Board 
 Mouse 
 Digital Camera 
 Webcam  
 Scanner etc 

 
 

 

 

 

WHAT IS HARDWARE? 

REVISION: 

Data: Raw Facts, figures, events and transactions are called data 
Information: Meaning full data is called information or processed data is 
called information” 
Computer: Computer is an electronic device which takes some input, process it, and 
produce output. 
Components of computer: Input, Output, CPU 
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The term hardware refers to the physical parts of the computer. Computer hardware is 
versatile-what it does depends on the computer program you use. All components which are 
tangible (touchable) are called Hardware  

Examples: Mic, Keyboard,Hard Disk, Scanner, Printer etc 

WHAT IS SOFTWARE? 

Software is the set of instructions (also called a program) that guides the hardware through its 
job. That tells the computer what to do? And how to do it? All components which are non 
tangible (Not Touchable) are called software. 

Examples: Ms Office, Operating Systems, Adobe photo shop etc 
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1) KEYBOARD 

Definition:   

“Keyboard is an input device, that contain keys user press to enter data or instructions in to 
the computer”. 

You enter most input data into the computer by using a keyboard. This input method is 
similar to typing on a typewriter.  

Most typewriter and computer keyboards are QWERTY keyboards. The alphabetic keys are 
arranged so that the upper-left row of letters begins with the six letters Q W E R T Y. 
Designers of other keyboards claim that their boards are easier to learn than the QWERTY 
keyboard.  

 

KEYS OF KEYBOARD 

Computer keyboards include keys that are designed to perform specific tasks. These keys 
enable the user to perform complex tasks easily when using the application. For example, 
many applications use a function key to access online help for the user. 

Keyboard keys consist of 

 Alphabetic keys 
 Numerical keys 
 Symbols 
 Functional keys 
 Extra keys 

Alphabetic keys contain alphabets from A-Z & a-z 

Numerical keys contain numbers 0-9 
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Symbols keys contain many symbols like !, @, #, $, % etc 

Functional keys contain f1-f12, design for special purpose will discuss latter. 

Extra keys contain Esc, Alt, Ctrl, Backspace, Enter etc  

 

2) POINTING DEVICES 

 

Definition: 

A pointing device is an input device which is used to control a pointer on a screen. Pointer is 
a small symbol on a screen. 

A pointing device is an input interface (specifically a human interface device) that allows a 
user to input spatial (i.e., continuous and multi-dimensional) data to a computer. CAD 
systems and graphical user interfaces (GUI) allow the user to control and provide data to the 
computer using physical gestures — point, click, and drag — for example, by moving a hand-
held mouse across the surface of the physical desktop and activating switches on the mouse. 
Movements of the pointing device are echoed on the screen by movements of the pointer (or 
cursor) and other visual changes. 

 

 

2.1) MOUSE 

Definition: 
 
“Mouse is an input device that fits under palm of hand and Controls movement of pointer, 
also called mouse”  
 

The mouse is a palm-size device with a ball built into the bottom. The 
mouse is usually connected to the computer by a cable (computer wires are 
frequently called cables) and may have from one to four buttons (but 
usually two).  Mice come in many shapes and sizes. When you move the 
mouse over a smooth surface, the ball rolls, and the pointer on the display 
screen moves in the same direction.  

With the mouse, you can draw, select options from a menu, and modify or move text. You issue 
commands by pointing with the pointer and clicking a mouse button. In addition to minimizing typing 
errors, a mouse makes operating a microcomputer easier for beginning. 

TYPES OF MOUSE 
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There are three types of mouse 

1. Mechanical mouse 
2. Optical mouse 
3. Wireless mouse 

 

 

 

 

 

 

MECHANICAL MOUSE: 

The mouse that contains a metal or rubber ball on its under side. When the ball is rolled in 
any direction, sensors inside the mouse detect this motion and move the on-screen mouse 
pointer in the same direction (picture above). 

 

OPTICAL MOUSE: 

An optical mouse uses a light-emitting (laser) to detect movement relative to the underlying 
surface. 

 

 

WIRELESS MOUSE: 

Wireless mice usually work via radio frequencies commonly referred to as RF. RF wireless 
mice require two components to work properly a radio transmitter and a radio receiver. 

 

2.2) JOY STICK 

A joystick is a pointing device often used for playing games. The 
joystick has a gearshift-like lever that is used to move the pointer on 
the screen. On most joysticks, a button on the top is used to select 
options. In industry and manufacturing, joysticks are used to control 
robots. Flight simulators and other training simulators also use 
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joysticks. 

 

 

 

 

2.3) TRACKBALL 

A trackball is like an upside-down mouse. Used similarly to the mouse, the trackball is 
frequently attached to or built into the keyboard.  

The main advantage of a trackball is that it requires less desk space than a mouse. (Some 
individuals in the computer industry believe that the mouse will soon be replaced by devices 
that do not require as much space to use.) 

The mouse is not practical for people using a laptop computer in a small space. Early 
alternatives, such as trackballs clipped to the side of the keyboard, have not proved 
satisfactory. The IBM ThinkPad replaces the trackball with a red plastic button, called a track 
point, located in the middle of the keyboard. You move the button with your thumbs. 
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2.4) TOUCHPAD 

A touch pad is a device for pointing (controlling input positioning) on a computer display 
screen. It is an alternative to the mouse. Originally incorporated in laptop computers, touch 
pads are also being made for use with desktop computers. A touch pad works by sensing the 
user's finger movement and downward pressure. 

 

 

 

 

 

 

2.5) TOUCHSCREEN 

A touch screen is a computer display screen that is also an input device. The screens are 
sensitive to pressure; a user interacts with the computer by touching pictures or words on the 
screen. 

 

 

 

 

 

2.6)  DIGITAL PEN 

A digital pen is a battery-operated writing instrument that allows the user to digitally capture 
a handwritten note or drawing. Typically, a digital pen comes with a Universal Serial Bus 
(USB) cradle to let the user upload the handwritten notes to a personal computer (PC).  
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The pen looks like a regular ball-point pen and can be used as such, but requires special digital paper 
if the user wishes to digitally capture what he has written. A page of digital paper, which can be 
purchased in traditional pad or sticky-note size, has small dots on it that allow the pen to "see" what 
has been written. 

 

 

 

2.7) LIGHT PEN 

A light-sensitive stylus wired to a video terminal used to draw pictures or select menu 
options. The user brings the pen to the desired point on screen and presses the pen button to 
make contact. Contrary to what it looks like, the pen does not shine light onto the screen; 
rather, the screen beams into the pen. Screen pixels are constantly being refreshed. When the 
user presses the button, the pen senses light, and the pixel being illuminated at that instant 
identifies the screen location. 

 

 

 

 

2.8) WHEEL 

Steering wheels are gaming devices used in driving games. All 
steering wheel controllers come with a wheel, accelerator, and 
brake; some steering wheel controllers allow "manual" (i.e., gear-to-
gear) shifting, while others only have high-low or forward-reverse 
options. A whole range of  racing wheels have been developed to 
make the experience of driving more realistic. And with the 
development of force feedback you can feel the actual resistance 
particular types of steering have. For example, riding a motorcycle is 
quite different than flying a helicopter or driving a car or tank. 

 

 

 



Chapter No 2:  Components of Computer‐Input Devices 

15 
 

3) BIOMETRIC DEVICES 

A "biometric device" is any device that measures a biological function or trait. it identifies 
persons seeking access to a computing system by determining their physical characteristics 
through fingerprints, voice recognition, retina patterns, pictures, weight, or other means. 

 

3.1) VOICE RECOGNITION 

A system in which the computer recognizes human speech and transforms the recorded words 
into computer-readable digitized text or instruction. 

The conversion of spoken words into computer text. Speech is first digitized and then 
matched against a dictionary of coded waveforms. The matches are converted into text as if 
the words were typed on the keyboard. 

 

 

 

 

 

 

3.2) THUMB IMPRESSION 

Biometrics can be defined as an automatic method for 
identification or identity verification of individuals using 
physiological or behavioral characteristics. 
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3.3) SIGNATURE VERIFICATION 

Digital signature unit capture and save signatures as people sign on the LCD touch screens. 
These signatures can be saved for use to electronically sign documents, customer signature 
verification for POS transactions, or employee authentication. Get your electronic signature 
capture system today. 

 

 

 

 

 

3.4) RETINA SCANNER 

 Retina scanner is used to map the unique patterns of a person's retina. it uses the unique 
patterns on a person's retina to identify them. 

It is used for authentication and identification purposes. Retinal scanning has been utilized by 
several government agencies including the FBI, CIA, and NASA. However, in recent years, 
retinal scanning has become more commercially popular. Retinal scanning has been used in 
prisons, for ATM identity verification and the prevention of welfare fraud. 
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3.5) FACE RECOGNITION 

The ability to recognize people by their facial characteristics. The most advanced technology 
, which maps the characteristics of a person's face into a multidimensional face space. The 
computer can distinguish the same person with different appearances; for example, with or 
without glasses, change of hair style and seasonal skin color changes. It also uses in some 
secret agencies. 

 

 

 

 

 

 

 

 

 

 

 

4) MIC/ HEAD PHONE 

Both are input devices which are related to audio input. These device is used to enter sound in 
to the system for processing. It can be used in chatting, video conferencing, music or 
whenever we want to interact with the computer from voice input. 
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5) DIGITAL CAMERA 

A digital camera can be used to take pictures.  It can be hooked up to a computer to transfer 
the pictures from the camera to the computer. it use light sensitive processing chip to capture 
pictures or images 

We can save these images where ever we want can be a CD, Computer disk, USB drive or 
can transfer from one computer to other computer or device. 

 

 

 

 

 

 

6) DIGITAL SCANNER 

A scanner is used to copy pictures or other things and save them as files on the computer. A 
scanner is similar to a photocopier, except that instead of producing a paper copy of the 
document you place on it, you get an electronic copy which appears on your computer screen. 
This is very important input device use to convert a hardcopy file (printed paper) to a 
softcopy (image or display file). 
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Chapter No 3 

COMPONENTS OF COMPUTER 

OUTPUT DEVICES 

 

 

 

 

 

 

WHAT IS OUTPUT? 

An output is the data that has been processed in that form which is useful by user or machine for 
future processing. Output can be in two forms Soft Copy and Hard Copy. (Describe further) 

WHAT ARE OUTPUT DEVICES? 

 Any hardware component used to show results after processing to any user and it use to send 
the results of processing to the user. Output can be text, Audio, Video & graphics. 

 

Examples  

 Monitor 
 Printer 
 Plotter 
 Projectors 

 Speakers  
 Headphone etc 

 
 

 

REVISION: 

Components of computer: Input, Output, CPU 
Input: Any data which is entered to computer for processing. 
Input Devices: The Hardware components to do input. 
Key Board, Mouse, Track ball, touch pad, speakers etc are input devices 
There are many other biometric devices used to do input like voice 
recognition and retina scanners. 
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1) MONITOR/DISPLAY DEVICES 

Definition:   

“Monitor or display devices are used to get output on screen. It is like small television and 
available in different sizes and specifications. The text which is displayed on screen is called 
softcopy (as defined above)” 

TYPES OF MONITOR 

 There are majorly two type of monitor according to its specification. These are 

 Monochrome monitor 
 Color monitor 

1.1) MONOCHROME MONITOR 

Monochrome monitor is based on a single color that can be white, blue, black or gray etc. 
these type of monitors is same like the old mobile phones which have a single color in back 
ground with black text in display. That is very much useful in these devices where we need 
simple display. Like some ATM machines, mobile phones, specific digital devices like PDA, 
pagers etc 

1.2) COLOR MONITOR 

Color monitor is such monitor which is based on colors as its name implies. Today mostly 
monitor are based on color display rather it is flat panel or tube based monitors. The basic 
colors in that monitors are three which are RGB stands for Red, Blue, Green by these basic 
colors a monitor can generate many other colors by the combination of these basic colors. 

 

1.2) COLOR MONITORS 

 

FEATURES & SPECIFICATIONS 

When we talked about monitor specification and features then there are several factors which 
we have to keep in our view. Whenever we want to buy monitor we have to keep these 
features in our view, defined as under:  

 
 

 Color 
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 Size 
 Resolution 
 Pixel Pitch 
 Refresher rate  

 
 
COLOR 
 
Monitor can view different colors specifically some monitor can view only single color in its 
background and black text on its screen these monitors are very simple (as defined above) is 
called monochrome monitors. 
 
Monitor work with three basic colors and by these three colors it makes different colors in by 
combinations. These colors are RGB, mean Red, Green and Blue. By combinations it can 
make 256 colors. More colors more exclusive display. 
 

SIZE 

Like television monitor is also available in different sizes. The size started from15 inches to 
22 inches monitor. 

RESOLUTION  

An important characteristic of all monitor screens is its resolution. The screen is divided in to vertical 
and horizontal lines and intersecting of these lines make many small boxes and these boxes in used to 
display images, called pixels 

 

 

 

 

Each point of light on the screen is called a pixel. The resolution of a screen is the number of pixels 
that the screen can display. This is given as the number of pixels across (horizontal resolution) by the 
number of pixels down (vertical resolution). For example, 800 x 600. The greater the resolution the 
better. Modern screens can display 1024 X 768 or better.  

PIXEL PITCH  

The distance between two pixels on screen is called pixel pitch. it is also an important feature of 
monitor. If we want to view clear images on monitors it must have less distance between pixels. That 
pixel pitch is also called dot pitch.  It is measured in millimeters. 

REFERESHER RATE  

Every monitor has a electric gun behind screen. That gun omits light and makes images to the screen. 
Refresher rate is that time which gun used to regenerate new image on screen. Refresher rate is 

Pixel 
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measured in hertz .it is also an important feature for better quality of display. , this is the number of 
times the image is refreshed every second. A low refresh rate makes the image appear to 
flicker. You need a refresh rate of at least 72 Hz (72 times a second) to avoid the appearance 
of flicker.  

 

 

1.2.1) CRT MONITORS 

The cathode ray tube (CRT) type monitors and makes use of the same technology as a 
television screen. A beam of electronics is fired from an electronic gun at the back of the 
tube. This strikes the front of the tube which is covered in a phosphorescent material which 
glows when struck by electrons. Between the electron gun and the screen the beam is 
modulated by a signal to produce the image you see on the screen. 
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1.2.2) LCD MONITORS 

The LCD monitors bring lots of advantages when compared 
to the CRT ones. The first advantage which is also the most 
obvious one is the fact that the LCD monitors are smaller and 
have a smaller weight than the CRT monitors.  

The LCD monitors can be placed on the table and they use far 
less space than the CRT monitors. This is a great advantage. 
The picture quality of the LCD monitors will be increased as 
well which means that the movies will be displayed in a better 
quality and the games will have better colors, and so on. 

In most of the cases the LCD monitors will have certain features which provide additional 
functionality. Some of the LCD monitors have USB hubs, HDMI input, TV tuner, and so on. The TV 
tuner is very important because you can use the computer for watching TV. The aspect ratio of the 
monitors has changed.  
 
The resolution will be highly influenced by the monitor size. The larger the size of the monitor is the 
larger resolutions it will have. If you buy the biggest monitor that you can buy because the 
experience of watching movies or playing games on it will be much more enjoyable. This was my 
info on the LCD computer monitors.  

1.2.3) GAS PLASMAMONITORS 

A gas-plasma display works by sandwiching neon gas between two plates. Each plate is 
coated with a conductive print. The print on one plate contains vertical conductive lines and 
the other plate has horizontal lines. Together, the two plates form a grid.  

When electric current is passed through a horizontal and vertical line, the gas at the 
intersection glows, creating a point of light, or pixel. You can think of a gas-plasma display 
as a collection of very small neon bulbs. Images on gas-plasma displays generally appear as 
orange objects on top of a black background. 
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1.2.4) TOUCH SCREEN MONITORS 

These monitors use touching of the screen as an input method. Items 
can be selected or moved with a finger, and finger gestures may be 
used to convey commands. The screen will need frequent cleaning due 
to image degradation from fingerprints. 

 

 

 

2) PRINTERS 

The second most common form of computer output is printed documents. Although a 
computer can operate perfectly without a printer, it is certainly helpful to the user to have 
one. People often prefer to get printouts of the work they have done rather than to look at it 
on the screen it is considered a form of hard 
copy.  

Types: 

Printer has majorly two types.  

 Impact printers  

 Non impact printers 

 

 

2.1) IMPACT PRINTERS 

Impact printers produce output by striking a ribbon with a hammer. When the ribbon is hit a 
mark is made on the paper behind it. If carbon paper is put into the printer then an impact 
printer can print more than one copy of a document at a time. This feature is often used by 
companies when they print invoices, bills etc. Because of the hammering action impact 
printers are noisy when they are printing. 
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2.1.1) DOT MATRIX PRINTERS 

Dot matrix printers produce an image by hammering a column of 9 or 24 pins against a 
ribbon. Characters are produced as the print head (which contains the pins) moves across the 
page.  

 

 

 

 

Dot matrix printers are cheap to purchase and have low operating costs. Most can run in 
either draft mode (quick but very low quality) or Near Letter Quality mode (slower but better 
quality). The disadvantages of dot matrix printers are that the output quality is poor, it takes a 
long time to print a document and the noise can be annoying.  

 

2.1.2) DAISY WHEEL PRINTERS 

Daisy wheel printers are rarely used any more. A daisy wheel printer hammers character 
stamps (like those on typewriters) against a ribbon to produce high quality text output. The 
character patterns are all arranged around the edge of a wheel.  

When a letter is to be printed the wheel rotates so that the correct letter is against the ribbon. 
A hammer then hits the letter against the ribbon to print it on the paper. Daisy wheel printers 
are very slow and noisy. It is not possible to print graphics using a daisy wheel printer. 
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2.1.3) LINE PRINTERS 

Dot matrix and daisy wheel printers both print only one character at a time. For that reason 
they are called Character Printers. In contrast a line printer prints a whole line (typically 80 or 
132 characters) of text at a time. These printers are very fast. They are expensive to buy and 
are used when high volumes of output are required. Example applications include printing 
telephone bills or bank statements. The main drawback to line printers is that they can 
produce only text--no graphics 

 

 

 

 

 

 

 

 

2.2) NON IMPACT PRINTERS 

Non-impact printers do not produce images by hammering pins or characters against the 
paper. Because there is no hammering action non-impact printers are very quiet but cannot 
print multiple copies using carbon paper. 

2.2.1) INK JET PRINTERS 

Ink jet printers are the most popular type of printer for use 
at home or in a small business. This is because they are 
relatively cheap to purchase and can print in color. Ink jet 
printers generate output by squirting tiny jets of ink at the 
paper to be printed on. 

 A column of ink jets in the print head moves across the 
page squirting dots onto the page to make the image. 

 Typically ink jet printers can produce 360 or 720 dots per inch (dpi) but these dots are larger 
than those that a laser printer makes so the quality although very good is not quite as perfect. 
Ink-jet printers can work in black and white or color. Black and white versions cost from Rs 
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5,000 and color ones from about 10,000. They are slower than laser printers (3ppm) and cost 
slightly more to run. 

2.2.2) LASER PRINTERSS 

Laser printers are called Page Printers because they print a whole page at a time. A laser 
beam is used to draw the image to be printed onto a light sensitive Drum. After the image has 
been drawn on the drum a fine powder ink called Toner is put onto it. The toner only sticks 
where the laser has drawn the image. The paper then passes over the drum and the toner is 
transferred onto the paper.  

 

 

 

 

 

Laser printers produce very high quality output, are very quiet and very fast. Typical home 
laser printers can print 8 pages per minute (ppm). Some industrial versions print over 40ppm 
and can print on both sides of a piece of paper at the same time. The main disadvantage of 
this type of printer is the high cost. Small laser printers cost from Rs 3,000 to buy and are 
more usually about Rs 8,000. Color laser printers cost Rs 30,000+. Running costs are higher 
than impact printers but lower than most ink jet printers. 

2.2.3) THERMAL PRINTERS 

Thermal printers are no longer used as printers for PCs. They are however still used in some 
computer control systems, tills and in many fax machines. These printers print on special heat 
sensitive paper which is expensive. The image is produced from small dots which are made 
on the paper by heating it up. The quality is reasonable and graphics can be printed. 
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2.2.4) PHOTO PRINTERS 

A printer specialized for smaller prints such as 4x6" and 5x7". When 
first introduced in the mid-1990s, photo printers used dye sublimation 
for high quality printing because inkjet printing was not quite up to 
par. Since then, inkjet technology has greatly improved, and most 
photo printers are inkjets. Epson, Canon and HP are major players in 
this market 

 

2.2.5) MOBILE PRINTERS 

A monitor is portable and we can take it any where we want. Mobile printers are making it 
easier and faster for us to free our trapped images from their digital prisons -- all without 
using a drop of ink. 

Without ink, it can be dramatically smaller than their predecessors, making them more 
convenient and even portable. It is said to be "mobile" because it receive wireless signals to 
print. However, with inkless printing technology, printers can be mobile in a more radical 
way -- you can carry it around in a pocket or a purse, just like a cell phone 

 

3) PLOTTERS 

A plotter, like a printer, produces hard-copy output. 
Plotters, which produce high-quality color graphics, are 
usually categorized by whether they use pens or 
electrostatic charges to create images. A continuous-curve 
plotter is used to draw maps from stored data. Computer-
generated maps can be retrieved and plotted or used to 
show changes over time. Plotters are generally more 
expensive than printers, ranging from about 100,000 to 
$750,000 (or even more). 
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4) SPEAKERS/ HEADPHONE 

Speakers and headset is used to get audio output. A system's speaker is 
the component that takes the electronic signal stored on things like CDs, 
tapes and DVDs and turns it back into actual sound that we can hear. In 
any sound system, ultimate quality depends on the speakers. The best 
recording, encoded on the most advanced storage device and played by a 
top-of-the-line deck and amplifier, will sound awful if the system is 
hooked up to poor speakers. 

 

 

 

5) MULTIMEDIA/PROJECTORS 

A Digital Projector/Multimedia is an electo-optical machine which converts image data 
from a computer or video source to a bright image which is then imaged on a distant wall or 
screen using a lens system. The cost of a device is not only determined by its resolution, but 
also by its brightness. The projector serves the following purposes:  

 Visualization of data stored in a computer for presentations  

 Demonstration of program products for a large number of prospective customers  

 The projector replaces the white board as well as written documents.  

 Watching moving images from a video tape player or digital video disk player.  

 Digital projectors may also be built into cabinets which use a rear projection screen to 

form a single unified display device, now popular for "home theater" applications. 
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Chapter No 4 

COMPONENTS OF COMPUTER 

SYSTEM UNIT 

 

 

 

 

 

WHAT IS SYSTEM UNIT? 
After input and output unit of the system, the main and very important component is System unit. 
System unit is a case that contains all components which are very important for the processing of 
data. 

The main components of 
system unit are here under: 

 Mother Board 

 CPU 

 Primary Memory 

 Ports & connectors 

 Expansion slots & 
Adaptor Cards 

 Buses  

 Power supply 

REVISION: 

Components of computer: Input, Output, CPU 
Output: An output is the data that has been processed in that form which is useful by user. 
Output Devices: The Hardware components to view results after processing. 
Monitor, printer, plotter, speakers/headphone, projectors. 
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4.1) MOTHER BOARD 

The main board of a computer, usually containing the circuitry for the central processing unit, 
keyboard, and monitor and often having slots for accepting additional circuitry. Also called the 
"system board," "main board" "base board" or "logic board,"  

it is the primary printed circuit board in a computer or other electronic device. In a modern 
desktop computer, the motherboard contains the CPU, chipset, sockets for memory, as well as all 
the controller circuits for the disks, keyboard, mouse, network, sound and USB. It may also have 
a PCI-Express slot for a high-end display adapter and PCI slots for additional peripherals. Laptop 
motherboards typically have all the peripheral controllers built in.  

 

 

 

 

 

 

 

 

 

Shortly we can define it as  

 Main circuit board in system unit 

 Contains chips, integrated circuits, and transistors 

 Also called system board 
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4.2) CENTRAL PROCESSING UNIT 

The CPU stands for Central Processing Unit, is the part of a computer system that is commonly 

referred to as the "brains" of a computer. The CPU is also known as the “processor” or 

“microprocessor”.  

The CPU is responsible for executing a sequence of stored instructions called a program. The 

programs tells a computer what to do and how to do? This program will take inputs from an 

input device, process the input in some way and output the results to an output device. 

 

 

 

 

 

 

 

 

 

 

 

 

 

CPUs aren’t only found in desktop or laptop computers, many electronic devices now rely on 

them for their operation. Mobile phones, DVD players and washing machines are examples of 

equipment that have a CPU.CPU is located in motherboard. The speed of processing of CPU is 

about 500 MHz to 2.5 GHz. 

INPUT  OUTPUT PROCESS 

CPU/Processor 
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PARTS OF CPU 

CPU is subdivided in to three parts defined below: 

1. ALU 
2. CU 
3. Register 

 

CPU 

 

 

 

 

 

1) ARITHMETIC & LOGICAL UNIT 

ALU stands for “Arithmetic and Logical unit”. This unit of the CPU is capable of performing 
arithmetic and logical operations. This unit of the CPU gets data from the computer memory and perform 
arithmetic and logical operations on it.  

 

ALU is further divided in to two parts, Arithmetic unit & Logical unit. 

ARITHMETIC UNIT: 

 The arithmetic unit of ALU performs arithmetic operations like addition, multiplication, subtraction and 
division.  

LOGICAL UNIT: 

The Logical unit of ALU performs logical operations such as comparison of two numbers. It tells us 
which number is greater and which is smaller. The common comparisons such as less than, equal to, or 
greater than are performed by the logical unit. 

REGISTERS: 

ALU 

CU 

Arithmetic & Logical Unit 

Control Unit 
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A processor has its own memory inside it in the shape of small cells. Each memory cell is called 
a "Register". Registers are used to carry data temporarily for performing operations. There are 
total 13 registers in a processor. ALU gets data from registers and stores it in registers to perform 
arithmetic and logical operations. And data comes in registers from main memory of the 
computer. 

2) CONTROL UNIT 

This unit of the processor controls all the activities of the processor and also controls the input 
and output devices of the computer. It acts just like a police inspector who controls the traffic on 
a road. 

 The control unit controls the whole traffic of the computer. It tells the input device that it is now 
his turn to feed data in the computer and show result of data after execution on the output units. 
This unit also controls the flow of instructions, which are given to a computer.  

It obtains instructions from the program stored in main memory, interprets (translation of 
instructions into computer language) the instructions, and issues signals that cause other units of 
the computer to execute them 

 

WORKING COLLECTING  

 

 

 

 

 

 

 

4.3) PRIMARY MEMORY 

The primary memory or the main memory is part of the main computer system. The processor or 
the CPU directly stores and retrieves information from it. This memory is accessed by CPU, in 
random fashion. That means any location of this memory can be accessed by the CPU to either 
read information from it, or to store information in it. 

INPUT  OUTPUT 
ALU 

CU 

Registers
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There are two types of memory CPU 

1. RAM 
2. ROM 

 

1) RANDOM ACCESS MEMORY (RAM) 

RAM is used to store programs and data that are being used by the computer. When the 
computer is turned on the RAM is empty. Data and programs can be put into RAM from either 
an input device or backing store.  

The data in RAM is lost when the computer is turned off so it is known as Volatile Memory. To 
keep data the user must save it to backing store before the computer is turned off. 

 RAM is further divided in to two types 

 DRAM (Dynamic Random access Memory) 

 SRAM (Static Random access Memory)  

 

 

 

 

 

DRAM 

DRAM stands for Dynamic RAM. A type of physical memory used in most personal computers. 
The term dynamic indicates that the memory must be constantly refreshed (reenergized) or it will 
lose its contents. RAM  is sometimes referred to as DRAM (pronounced dee-ram) to distinguish 
it from static RAM (SRAM). Static RAM is faster and less volatile than dynamic RAM, but it 
requires more power and is more expensive.  

SRAM 

SRAM stands for Static RAM. Short for static random access memory, and pronounced ess-ram. 
SRAM is a type of memory that is faster and more reliable than the more common DRAM 
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(dynamic RAM). The term static is derived from the fact that it doesn't need to be refreshed like 
dynamic RAM 

2) READ ONLY MEMORY (ROM) 
 

The contents of ROM are permanent. It cannot be altered by the user. The content is written onto 
the ROM when it is first made. ROM keeps its contents even when the computer is turned off 
and so is known as Non-Volatile Memory.  

 

On some computers a special piece of software called the operating system is stored in ROM. 
ROM is also often used in embedded systems where a small built-in computer is used to control 
a device such as a washing machine. The program that controls the machine is stored on ROM. 

 

 

 

TYPES OF ROM 

ROM is further divided in to three types 

 PROM  (Programmable Read-Only Memory) 

 EPROM (Erasable Programmable Read-Only 
Memory) 

 EEPROM (Electronically Erasable Programmable Read-Only Memory) 

PROM 

PROMs are manufactured as blank chips on which data can be written with a special device 
called a PROM programmer. 

EPROM 
A rewritable memory chip that holds its content without power. EPROM chips are written on an external 
programming device before being placed on the mother board. 

EEPROM 

A rewritable memory chip that holds its content without power. EEPROMs are typically used on 
circuit boards to store small amounts of instructions and data. 
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4.4) PORTS & CONNECTORS 
 
 

A personal computer may have several ports for connecting devices such as a trackball, 
expanded keyboard, flatbed scanner, touch screen, and other device peripherals.  
 
It is wise to check what type of port an adaptive device requires to interface with the personal 
computer. Some computers have many ports, and others may only have a select few of the ports 
below. 

 

 

 

 

 

 

 

 

 

TYPES OF PORTS: 

There are two types of ports 

 Serial port 

 Parallel port 

SERIAL PORT: 

Serial ports can transfer one bit at a time.  A serial communication physical interface through 
which information transfers in or out one bit at a time.  
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Throughout most of the history of personal computers, data transfer through serial ports 
connected the computer to devices such as terminals and various peripherals. 

This type of transmission medium is slow as it transmit one bit at a time. It can connect main 
peripherals of system unit. Like mouse, keyboard etc.  

 

 

 

 

(Serial port connector and port) 

PARALLEL PORT: 

Parallel port can transfer more that one bit a time. A parallel port is a type of interface found on 
computers for connecting various peripherals.  

In computing, a parallel port is a parallel communication physical interface. It is also known as a 
printer port or Centronics port.  

The IEEE 1284 standard defines the bi-directional version of the port, which allows the 
transmission and reception of data bits at the same time. It is faster then parallel port as it transfer 
more than one bit simultaneously  

(Note: Bit will be describe in next chapters) 
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4.5) EXPANSTION SLOTES & ADAPTOR CARDS 

 
Expansion slot is an opening, or socket, where circuit board is inserted into motherboard. 

Expansion card inserted in expansion slot. Plug and Play was a much-touted feature of the 

Windows 95 and Windows 98 operating systems. 

A PC Card slot, usually located on the side of a notebook computer, allows a PC Card to be 

changed without having to open the system unit. There are three types of PC Cards: 

 Type I cards add memory capabilities to the computer  
 Type II cards contain communications devices  
 Type III cards house devices such as hard disks  
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4.6) BUSES 

A highway analogy can help clarify how bus width affects the speed of data transfer. Data moves 
like cars – the more lanes (greater the bus width) the faster the traffic (data) flow. Ideally, buses 
used to transfer data should be large enough to use the processing power of registers. Sometimes, 
however, manufacturers reduce bus size to cut costs.  

Word size, which indicates the number of bits processed in each machine cycle, has been 
compared to the amount of coffee produced with each turn of a coffee grinder’s handle. 
Theoretically, if word size doubles then processor throughput also could double.  

 

 

 

 

 

 

 

 

 

 

 

TYPES OF BUSES 

 System bus 
 Expansion bus 
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SYSTEM BUS 
System bus connects processor and RAM. It is also called internal bus. it is subdivided in to two 

types: 

1. Address bus 

2. Data bus 

ADDRESS BUS 

The address bus is a unidirectional pathway that carries addresses generated by the 
microprocessor to the memory and I/O elements of the computer.  The size of the address bus, 
determined by the number of conductors in the bus, determines the number of memory locations 
and/or I/O elements the microprocessor can address. 

DATA BUS 

In contrast to the address bus, the data bus is bi-directional in nature.  Data flows along the data 
bus from the microprocessor to memory during a Write operation. Conversely, data moves from 
memory to the microprocessor during a Read operation.  The direction for data movement is the 
same for Read and Write operations between the microprocessor and Input/Output devices. 

 

EXPANSION BUS 

The expansion bus (sometimes called the input/output bus) allows various motherboard 
components (USB, serial, and parallel ports, cards inserted in PCI connectors, hard drives, CD-
ROM and CD-RW drives, etc. to communicate with one another. However, it is mainly used to 
add new devices using what are called expansion slots connected to the input/output bus. 

 

4.7) POWER SUPPLY 

 
It supply electric supply to all components of system unit. It Converts alternating current (AC) to 

direct current (DC). It is responsible for supply of power to all components according to its 
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voltage. Min voltage which power supplied is 3V and convert to 24 V.   Some peripheral devices 

have AC adapterlike printers and scanners. 
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Chapter No 4 

COMPONENTS OF COMPUTER 

SYSTEM UNIT 

 

 

 

 

 

WHAT IS DATA? 

“Raw facts, figures, events and transactions are called data”  

DATA REPRESENTATION 

Most computers are digital, meaning they understand only two discrete states: on and off. 
These states are represented using two digits, 0 (off) and 1 (on). Each on or off value is called 
a bit (short for binary digit), the smallest unit of data a computer can handle. “Eight bits” 
grouped together as a unit form a byte. A byte provides enough different combinations of 0s 
and 1s to represent 256 individual characters including numbers, letters of the alphabet, 
punctuation marks, and other characters. 

 

 

 

The combinations of 0s and 1s used to represent data are defined by patterns called coding 
schemes.  

REVISION: 

Components of computer: Input, Output, CPU 
System Unit: System unit is a case that contains all components which are very 
important for the processing of data. 
Component of System Unit: Mother Board, CPU, Primary Memory, Ports & 
connectors, Expansion slots & Adaptor Cards, Buses, Power supply 
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Popular coding schemes are ASCII (American Standard Code for Information Interchange) , 
EBCDIC, and Unicode. Coding schemes make it possible for humans to interact with a 
digital computer that recognizes only bits. Every character you type on a keyboard is 
converted into a corresponding byte, a series of on/off electrical states the computer can 
process. 
The common data representation is formed in to following divisions: 

 

NAME ABBR. SIZE 

1 Nibble N 4-bits 

1 byte B 8-bits 

1 kilo byte K 2^10=1024 bytes 

1 Mega byte M 2^20=1,048,576 

1 Giga Byte G 2^30=1,073,741,824 

1 Tera Byte T 2^40=1,099,511,627,776 

 

WHAT IS BINARY? 

The binary numbering system is used by today's computers due to its simplicity in electronic 
circuitry. Computer only work with two digits - 1 representing "on", and 0 representing "off" 
(or 1 and 0 representing "yes" or "no"). 
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HOW TO MAKE BINARY 

We can convert decimal function in to binary by following technique: 

Example: if we want to convert 156 in to binary then we will divide it by 2. 

2)156   0 
 2)78   0 
 2)39   1 
 2)19   1 
  2)9   1 
  2)4   0 
  2)2   0 
  2)1   1 

    0 

HOW IS A LETTER REPRESENTED IN SYSTEM PROCESSING? 

Data is represented in system by a life cycle defined below: 

 

 

Press P from keyboard                                                                                                          

 

 

Processing   

 

Display 
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WHAT IS STORAGE? 

A Storage Medium (media is the plural) is the physical material on which items are kept. A 
storage device is the computer hardware that records and retrieves items to and from a 
storage medium. Storage devices can function as sources of input and output.  

When storage devices transfer items from a storage medium into memory – a process called 
reading – they function as sources of input. When storage devices transfer items from 
memory to a storage medium – a process called writing – they function as sources of output. 
Types of storage media include floppy disks, hard disks, compact discs, tape, PC Cards and 
microfilm etc. 

DIFFERENCE B/W MEMORY & STORAGE MEDIUM 

Memory, which is composed of one or more chips on the motherboard, is a temporary 
holding place for data and instructions during processing. The contents of volatile memory, 
such as RAM, are lost when the power to the computer is turned off.  

The contents of nonvolatile memory, such as ROM, are not lost when power is removed 
from the computer.  

Storage holds items such as data, instructions, and information for future use; that is, storage 
holds these items while they are not being processed. Storage is nonvolatile, which means the 
items in storage are retained even when power is removed from the computer. Compared to 
memory, the access time (the time it takes to locate a single item) for storage is slow. 

TYPES OF STORAGE MEDIUM 

Storage medium is further divided in to three important forms. 

1. Magnetic Tapes  
2. Magnetic Disks  
3. Optical Disks 
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1) MAGNETIC TAPE 

Magnetic tape was developed in the mid-1950s to replace the earlier method of storing data 
on punched cards. To better understand the difference between sequential access and direct 
access (or random access), compare an audio cassette tape to a CD-ROM. An audio cassette 
tape is sequential; to listen to the fourth song it is necessary to listen to (or fast-forward 
through) the first three songs.  

With tape backup, you can press a key; go about other business, and return to remove the 
finished backup tape. 

TYPES OF MAGNETIC TAPE: 

Magnetic tape comes in two different forms: 

1. Reels 
2. Cartridges  

REELS: 

Large reels of tape (1/2 inch wide and 2400 feet long) which must be loaded into a reel-to-
reel tape drive. This type of tape is usually used by mainframe computers.  

 

 

 

 

 

 

 

CARTRIDGES: 

 The tape is supplied in a small cartridge rather like a music tape. The tape is typically 1/4 
inch wide and 300 feet long. This type of tape is used on PCs (microcomputers) and the 
device used to read/write the tapes is called a Tape Streamer.  

The picture below is of a tape streamer for a PC. Capacities of cartridges vary from 80Mb to 
10Gb. Tape cartridges can be purchased formatted or unformatted. One-quarter-inch wide 
cartridge tapes typically are 600 feet long. Unattended tape backup is a great time saver. 
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2) MAGNETIC DISKS 

Magnetic Disks are the most common storage device. Data is stored using magnetized spots 
called domains on the disk. A 3.5" 1.44Mb floppy disk used on a PC contains 16,777,216 
such spots. A 3.5" 1Gb hard disk drive contains over a billion spots. 

Data stored on disks is arranged along a series of concentric rings called Tracks. Each track 
is divided up into a number of Sectors. Data is read to and written from a disk one sector at a 
time. A sector usually contains 512 or 1024 bytes of data. 

 

 

 

 

 

 

 

The process of dividing a disk up into tracks and sectors so it can be used on a computer is 
known as formatting. You must format a new disk before you can use it. 

Data is read from the disk using a disk head which moves mechanically about the disk 
(rather like a record player tone arm). The disk head can move directly to any sector on the 
disk. Because of this a computer system can load a file or a record from a file very quickly. 
The system can move directly to the location of the record/file and read it without having to 
read any other data from the disk. This is known as direct access. For most applications 
using a direct access medium is much faster than using a serial access medium. 

TYPES OF MEGNATIC DISK 

The three main types are:  

1. Floppy disks 
2. Magnetic disks  
3. Hard disks 

FLOPPY DISK 

Floppy disks are portable (can be moved between computers) but have a small storage 
capacity. Reading and writing data from a floppy disk is very slow. The most common type 
of floppy disk is the 3.5" disk that can store 1.44Mb of data when it is used on a PC. Older 
disks were 5.25" or 8" in size but could store much less data. 
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A floppy disk is manufactured from a flexible plastic disk. This disk is coated with a 
magnetisable material. For protection the disk is encased in a plastic shell. All sizes of floppy 
disk have a write protect tab built into the shell. If this tab is set then data can be read from 
the disk but not written to it. The write protect tab can be used to prevent important data 
being deleted or changed accidentally. 

 

 

 

 

 

HARD DISK 

Hard disks have much larger storage capacities than floppy disks. Data can be transferred to 
and from a hard disk much more quickly than from a floppy disk. Hard disks are usually 
fixed inside a computer and cannot be moved between different machines. Some expensive 
hard disks can be moved between computers. These are called Exchangeable Hard Drives. 

A hard disk is made of a rigid disk which is coated with a magnetisable material. The 
magnetic material used is of a much higher quality than that found on floppy disks. Hard 
disks spin much more quickly than floppy disks and the disk head is positioned very close to 
the disk (thousandths of a millimeter away).  

Because the disk head is positioned so close to the disk hard drives can easily be damaged by 
dust or vibration. Therefore the disk, the drive head and all the electronics needed to operate 
the drive are built together into a sealed unit.  

This picture shows a hard disk drive with the case removed. 
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Usually (as in the picture above) several physical disks are contained in one hard disk unit. 
Each disk is known as a platter. Typical hard disk capacities for a home PC now start at 1Gb 
and units storing up to 16Gb are available.  

If larger storage capacities are required then multiple hard drives can be combined. Using 
appropriate hardware or software many hard disks can be made to look like one very large 
hard disc to the user. 

ZIP DISK 

The Zip drive is a high-capacity disk drive that uses a Zip disk. The Zip disk is larger and 
thicker than a 3.5-inch floppy disk and can store 100 MB or 250 MB of data. The Zip drive 
is a medium-capacity removable disk storage system, introduced in late 1994. Originally, Zip 
disks launched with capacities of 100 MB, but later versions increased this to first 250 MB 
and then 750 MB. 
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The format became the most popular of the super-floppy type products which filled a niche in 
the late 1990s portable storage market. However it was never popular enough to replace the 
3.5-inch floppy disk nor could ever match the storage size available on rewritable CDs and 
later rewritable DVDs. USB flash drives 

3) OPTICAL DISK 

Optical disks store data by changing the reflective properties of a plastic disk. Binary 
computer data (0s and 1s) are represented by the way the disk reflects light when a low power 
laser is shown at it. A 0 stored on a disk reflects light differently to a 1 stored on a disk. Like 
floppy disks, optical disks can be moved from one computer to another.  

They have much larger storage capacities than floppy disks but cannot store as much data as a 
hard disk. Data can be read from an optical disk more quickly than from a floppy disk but 
hard disks are much quicker. As with a hard disk the drive head in an optical drive can move 
directly to any file on the disk so optical disks are direct access. 

There are four types of optical disks that are currently in use. They are: 

1. CD-ROM 
2. CD-R 
3. CD-RW 
4. DVD 

 

 

 

CD-ROM  

CD ROM stands for Compact Disk - Read Only Memory This is by far the most widely 
used type of optical disk. A CD-ROM disk can store up to 650Mb of data. The data is written 
onto the CD-ROM disk before it is sold and cannot be changed by the user. Because of this 
CD-ROMs are often described as Write Once Read Many times (WORM) disks. CD-
ROMs are used for applications such as distributing software, digital videos or multimedia 
products. 

CD-R 

CD-R stands Compact Disc – Recordable. CD-R disk can store up to 650Mb of data. A CD-
R disk is blank when it is supplied. The user can write data to it just once. After data has been 
written to the disk it can not be changed. A special CD-R drive which contains a higher 
powered laser than a CD-ROM drive is required to write to the disk. CD-Rs are often used for 
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making permanent backups of data and distributing software when only a small number of 
copies are required. 

 

 

 

 

 

 

 

 

 

CD-RW 

A CD-RW stands for Compact Disc - Read / Write. The disk can store up to 650Mb of data. 
CD-RW disks can be read from and written to just like a hard disk. CD-RWs can be used for 
any application that a hard disk can be used for but the time taken to access data is much 
longer than that for a hard disk. 

 

DVD  

DVD stands for Digital Versatile Disk or Digital Video Disk. This new standard for optical 
disks. By using a shorter wavelength laser, storing data on both sides of the disk and having 
more than one layer of data on each side of a disk DVD disks are able to store much more 
data than CD disks.  

The DVD standard includes disk capacities up to 18Gb. Current DVD disks store far less than 
this. There are two types of DVD disks. DVD-ROM disks can be read from but not written to 
whilst DVD-RAM disks can be read from and written. 
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STORAGE CAPACITIES 

 

 

USB FLASH DRIVE 

A flash drive is a small external storage device that reads and writes to flash memory, a 
solid-state storage medium that's both inexpensive and durable. Given that your typical flash 
drive is the size of an adult's thumb, it's not uncommon to hear of these ubiquitous devices as 
"thumb drives". Due to their portable nature and near-universal compatibility, flash drives 
have largely supplanted the floppy diskette as everyone's favorite method for transferring 
files between multiple computers without the use of a network. 

NAME STORAGE CAPACITY PORTABLE 

Floppy Disk 1.44Mb Yes 
Hard Disk 200Mb to 20Gb No 
Optical Disk 650Mb Yes 
Magnetic Tape 80Mb to 10Gb Yes 
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Chapter No 6 

HISTORY OF COMPUTER 
 

Computer word is derived from “Computing”. As the start of the modern science that we call 
"Computer Science" can be traced back to a long ago age where man still dwelled in caves or 
in the forest, and lived in groups for protection and survival from the harsher elements on the 
Earth.  

It was a man who decided when to hold both the secret and public religious ceremonies, and 
interceded with the spirits on behalf of the tribe. In order to correctly hold the ceremonies to 
ensure good harvest in the fall and fertility in the spring, the shamans needed to be able to 
count the days or to track the seasons. From the shamanistic tradition, man developed the first 
primitive counting mechanisms -- counting notches on sticks or marks on walls. 

Computing becoming more and more complicated then the first computing device came in to 
being that is Abacus 

ABACUS 

The first actual calculating mechanism known to us is the abacus, which is thought to have 
been invented by the Babylonians sometime between 1,000 BC and 500 BC, although some 
pundits are of the opinion that it was actually invented by the Chinese. 

The word abacus comes to us by way of Latin as a mutation of the Greek word abax. In turn, 
the Greeks may have adopted the Phoenician word abak, meaning "sand", although some 
authorities lean toward the Hebrew word abhaq, meaning "dust." 
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Irrespective of the source, the original concept referred to a flat stone covered with sand (or 
dust) into which numeric symbols were drawn. The first abacus was almost certainly based 
on such a stone, with pebbles being placed on lines drawn in the sand. Over time the stone 
was replaced by a wooden frame supporting thin sticks, braided hair, or leather thongs, onto 
which clay beads or pebbles with holes were threaded. 

A variety of different types of abacus were developed, but the most popular became those 
based on the bi-quinary system, which utilizes a combination of two bases (base-2 and base-
5) to represent decimal numbers. Although the abacus does not qualify as a mechanical 
calculator, it certainly stands proud as one of first mechanical aids to calculation. 

JOHN NAPIER CALCULATING DEVICE(1550-1617): 

John Napier developed the logarithms rules which are very useful in mathematics and 
computer technology. He was a Scottish mathematical scientist. The Logarithm table is 
designed by Napier as well which make revolutionary change in mathematics and Computing 

Napier's invention led directly to the slide rule, first built in England in 1632 and still in use 
in the 1960's by the NASA engineers of the Mercury, Gemini, and Apollo programs which 
landed men on the moon. This slide rules is used to take sin, cos, tangent and other 
trigonometric & arithmetic calculation. 

 

 

 

 

 

BLASÉ PASCAL CALCULATING DEVICE(1623-1662): 

In 1642 Blasé Pascal, at age 19, invented the Pascaline as an aid for his father who was a tax 
collector. Pascal built 50 of this gear-driven one-function calculator (it could only add) but couldn't 
sell many because of their exorbitant cost and because they really weren't that accurate (at that time it 
was not possible to fabricate gears with the required precision).  

Up until the present age when car dashboards went digital, the odometer portion of a car's 
speedometer used the very same mechanism as the Pascaline to increment the next wheel after each 
full revolution of the prior wheel. Pascal was a child prodigy. At the age of 12, he was discovered 
doing his version of Euclid's thirty-second proposition on the kitchen floor. Pascal went on to invent 
probability theory, the hydraulic press, and the syringe. Shown below is an 8 digit version of the 
Pascaline, and two views of a 6 digit version: 
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POLYMATH GOTTFRIED LEIBNIZ CALCULATING 
DEVICE (1646-1716): 

The great polymath Gottfried Leibniz was one of the first men, who dreamed for a logical 
(thinking) device. Even more Leibniz tried to combine principles of arithmetic with the 
principles of logic and imagined the computer as something more of a calculator—as a 
logical or thinking machine.  

He discovered also that computing processes can be done much easier with a binary number 
coding. He even describes a calculating machine which works via the binary system: a 
machine without wheels or cylinders—just using balls, holes, sticks and canals for the 
transport of the balls. 
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 JOSEPH MARIE JACQUARD CALCULATING DEVICE 
(1752-1834): 

Joseph Marie Jacquard (1752-1834) was a French silk weaver and inventor, who improved 
on the original punched card design of Jacques de Vaucanson's loom of 1745, to invent the 
Jacquard loom mechanism in 1804-1805. Jacquard's loom mechanism is controlled by 
recorded patterns of holes in a string of cards, and allows, what is now known as, the 
Jacquard weaving of intricate patterns. 

 

 

 

 

 

 

 

 

 

 

CHARLES XAVIER CALCULATING DEVICE (1785-1870): 

Charles Xavier Thomas de Colmar invented the first calculating machine to be produced in 
large numbers. This invention came about in France in 1820 as part of a national competition 
and the machine was called the Arithmometer. 
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The Arithmometer was essentially an early and large version of a pocket calculator 
(occupying the best part of a desk), and by 1845 there was a large, commercially successful 
industry involved in the manufacture of these machines. 

 

CHARLES BABBAGE CALCULATING DEVICE (1791-1871): 

 

The first glimmer of a "thinking machine" came in the 1830s when British mathematician 
Charles Babbage envisioned what he called the analytical engine. Charles Babbage is s 
considered as “Father Of Computing”.  Babbage was a highly regarded professor of 
mathematics at Cambridge University when he resigned his position to devote all of his 
energies to his revolutionary idea.  

 

 

 

 

 

 

 

 

In Babbage's time, the complex mathematical tables used by ship's captains to navigate the 
seas, as well as many other intricate computations, had to be calculated by teams of 
mathematicians who were called computers.  

No matter how painstaking these human computers were, their tables were often full of 
errors. Babbage wanted to create a machine that could automatically calculate a mathematical 
chart or table in much less time and with more accuracy. 

 His mechanical computer, designed with cogs and gears and powered by steam, was capable 
of performing multiple tasks by simple reprogramming—or changing the instructions given 
to the computer.  
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LADY AUGUSTA ADA (1816-1852): 

Lady Augusta Ada is mainly known for having written a description of Charles Babbage's 
early mechanical general-purpose computer, the analytical engine. Ada was a US 
governmental developed programming language. The standard was originally 
known as Ada83, but this is now obsolete, as it was recently "overhauled" and 
re-born as Ada95. This is now the preferred standard and implementation of the 
Ada programming language. 

 

 

 

 

 

 

 

 

HERMAN HOLLERITH (1860-1929): 

Herman Hollerith developed in 1890 the punched card system to store data. The punched 
card system was an important movement in the development of the computer. His idea was 
totally different from the principle already known by Babbage or by Colmar. He used the 
working method of a punch cutter on the train. His calculator was so successful that he 
started his own business to sell his product. Later the company was called International 
Business Machines (IBM). However the original cards could not be used for complicated 
calculations. 
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ATANASOFF BERRY COMPUTER: 

Atanasoff Berry Computer is the name given, long after the fact, to an experimental 
machine for solving systems of simultaneous linear equations, developed in 1938-42 at Iowa 
State University by Dr. John Vincent Atanasoff and Clifford E. Berry. It is sometimes 
referred to by its initials, ABC.  

The Atanasoff-Berry Computer, constructed in the basement of the Physics building at Iowa 
State University, took over two years to complete due to lack of funds. The prototype was 
first demonstrated in November of 1939. The computer weighed more than seven hundred 
pounds (320 kg). It contained approximately 1 mile (1.6 km) of wire. 

 

 

 

 

 

 

GEORGE BOOLE INVENTION (1847): 

English mathematician George Boole sets up a system called Boolean 
algebra,, wherein logical problems are solved like algebraic problems. 
Boole's theories will form the bedrock of computer science. 

 

The creation of an algebra of symbolic logic was the work of another mathematical prodigy 
and British individualist. . As Bertrand Russell remarked seventy years later, Boole invented 
pure mathematics. The design of circuits is arranged by logical statements and these 
statements return Zero (0) or one (1). This is called binary language.  
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MARK-I, ASCC (1944): 

The Harvard Mark I designed primarily by Prof. Howard Aiken launches today's computer 
industry. The Mark I is the world's first fully automatic computer and the first machine to 
fulfill Babbage's dream. 1945 

A programmable, electromechanical calculator designed by professor Howard Aiken. Built 
by IBM and installed at Harvard in 1944, it strung 78 adding machines together to perform 
three calculations per second. It is also known as ASCC (Automatic Sequence Controlled 
Calculator). It was 51 feet long, weighed five tons and used paper tape for input and 
typewriters for output. Made of 765,000 parts, it sounded like a thousand knitting needles 
The Mark I worked in decimal arithmetic, not binary, but it could go for hours without 
intervention. 
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ENIAC (1943-1946): 

ENIAC stands for Electronic Numerical Integrator and Computer. The first operational 
electronic digital computer developed for the U.S. Army by J. Presper Eckert and John 
Mauchly at the University of Pennsylvania in Philadelphia. Started in 1943, it took 200,000 
man-hours and nearly a half million dollars to complete two years later. 

Programmed by plugging in cords and setting thousands of switches, the decimal-based 
machine used 18,000 vacuum tubes, weighed 30 tons and took up 1,800 square feet. It cost a 
fortune in electricity to run; however, at 5,000 additions per second,  

It was faster than anything else. Initially targeted for trajectory calculations, by the time it 
was ready to go, World War II had ended. Soon after, it was moved to the army's Aberdeen 
Proving Grounds in Maryland where it was put to good work computing thermonuclear 
reactions in hydrogen bombs and numerous other problems until it was dismantled in 1955. 

 

ENVAC (1946-1952): 

In 1944, while working as a research associate at the Moore School, Dr John Von Neumann 
worked on the EDVAC (Electronic Discrete Variable Automatic Computer), greatly 
advancing the functions of its predecessor. Completed in 1952, EDVAC had an internal 
memory for storing programs, used only 3,600 vacuum tubes, and took up a mere 490 square 
feet (45 sq. m). 

He undertook a study of computation that demonstrated that a computer could have a simple, 
fixed structure, yet be able to execute any kind of computation given properly programmed 
control without the need for hardware modification. 
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Von Neumann contributed a new understanding of how practical fast computers should be 
organized and built; these ideas, often referred to as the stored-program technique, became 
fundamental for future generations of high-speed digital computers and were universally 
adopted.  

 

 

 

 

 

 

 

 

 

EDSAC (1946-1952): 

EDSAC stands for Electronic Delay Storage Automatic 

Calculator, was an early British computer. The machine, 

having been inspired by John von Neumann's seminal 

EDVAC report, was constructed by Professor Sir Maurice 

Wilkes and his team at the University of Cambridge 

Mathematical Laboratory in England. 

EDSAC was the world's first practical stored program 

electronic computer, although not the first stored program 

computer (that honor goes to the Small-Scale Experimental Machine). 

The project was supported by J. Lyons & Co. Ltd., a British firm, who were rewarded with 

the first commercially applied computer, LEO I, based on the EDSAC design. EDSAC ran its 

first programs on May 6, 1949, calculating a table of squares and a list of prime numbers. 
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UNIAC-I (1951): 

UNIVAC I. First-generation computer was characterized by a very prominent feature on the ENIAC, 

vacuum tubes. Until the year 1950, several other computers using these tubes, each computer 
provides significant advances in computer development. Development includes arithmetic 
binary, random access, and the concept of stored programs. 

1951 The U.S. Bureau of Census in 1951 installed the first commercial computer called the 
Universal Automatic Computer – UNIVAC I. UNIVAC I developed by Mauchly and Eckert 
for the Remington-Rand Corporation. 

The first IBM products are sold in the market is the IBM 701 in 1953. Remarkably, the IBM 
650 was introduced in the next year that may be the reason IBM is a big benefit in the 
previous year. To get rid of its competitors, the IBM 650 was made in order to upgrade the 
machine-punched-card machines available. That’s because IBM 650 data processing in a way 
similar to the traditional way of punched-card machines. 
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GENERATIONS OF COMPUTER 

The history of computer development is often referred to in reference to the different 
generations of computing devices. A generation refers to the state of improvement in the 
product development process. This term is also used in the different advancements of new 
computer technology. With each new generation, the circuitry has gotten smaller and more 
advanced than the previous generation before it.  

As a result of the miniaturization, speed, power, and computer memory has proportionally 
increased. New discoveries are constantly being developed that affect the way we live, work 
and play. 

Each generation of computers is characterized by major technological development that 
fundamentally changed the way computers operate, resulting in increasingly smaller, cheaper, 
and more powerful and more efficient and reliable devices.  

Read about each generation and the developments that led to the current devices that we use 
today. The generations which are divided in to fifth categories can be describe as: 

 

Generations Period Technology 

Early Period 1000 BC-1940 Many As describe in previous 
Chapter 

First Generation 1942-1955 Vacuums Tube 

Second Generation 1955-1964 Transistors 

Third Generation 1964-1975 Integrated Circuits (ICs) 

Forth Generation Since 1975 Microprocessor/Large Scale 
Integration 

Fifth Generation Since 1980 Artificial Intelligence  
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THE EARLY DAYS (1,000 B.C. TO 1940) 
 
Computers are named so because they make mathematical computations at fast speeds. As a 
result, the history of computing goes back at least 3,000 years ago, when ancient civilizations 
were making great strides in arithmetic and mathematics. The Greeks, Egyptians, 
Babylonians, Indians, Chinese, and Persians were all interested in logic and numerical 
computation. The Greeks focused on geometry and rationality, the Egyptians on simple 
addition and subtraction, the Babylonians on multiplication and division, Indians on the base-
10 decimal numbering system and concept of zero, the Chinese on trigonometry, and the 
Persians on algorithmic problem solving.  

These developments carried over into the more modern centuries, fueling advancements in 
areas like astronomy, chemistry, and medicine. 

(All other history from abacus to UNIVAC-I describe in previous Chapter) 

 

FIRST GENERATION (1942 - 1955) 

The first computers used vacuum tubes for circuitry and magnetic drums for memory, and 
were often enormous, taking up entire rooms. First generation computers relied on machine 
language to perform operations, and they could only solve one problem at a time. 

The Mark-I, EDSAC, EDVAC, UNIVAC-I and ENIAC computers are examples of first-
generation computing devices. It was very expensive to operate and in addition to using a 
great deal of electricity, generated a lot of heat, which was often the cause of malfunctions.  

Vacuum tubes used to calculate and store information, these computers were also very hard 
to maintain. First generation computers also used punched cards to store symbolic 
programming languages. Most people were indirectly affected by this first generation of 
computing machines and knew little of their existence. 
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IMPORTANT MACHINES: 

Mark-I, EDSAC, EDVAC, UNIVAC-I and ENIAC 

ADVANTAGES: 

1. After long history of computations, the 1G computers are able to process any tasks in 
milliseconds. 

2. The hardware designs are functioned and programmed by machine languages 
(Languages close to machine understanding). 

3. Vacuum tube technology is very much important which opened the gates of digital 
world communication. 

DISADVANTAGES: 

1. Size of that machines are very big 
2. Required large amount of energy for processing 
3. Very expensive 
4. Heat generated and need air conditioning. 
5. Not portable ( never take from one place to other) 
6. Comparing with 5G computers, these computers are slow in speed. 
7. Not reliable 
8. In order to get proper processing, maintenance is required continuously. 

 

SECOND GENERATION (1942 - 1955) 
 

Transistors replaced vacuum tubes and ushered in the second generation computer. 
Transistor is a device composed of semiconductor material that amplifies a signal or opens 
or closes a circuit. Invented in 1947 at Bell Labs, transistors have become the key ingredient 
of all digital circuits, including computers. Today's latest microprocessor contains tens of 
millions of microscopic transistors. 

Prior to the invention of transistors, digital circuits were composed of vacuum tubes, which 
had many disadvantages. They were much larger, required more energy, dissipated more 
heat, and were more prone to failures. It's safe to say that without the invention of transistors, 
computing as we know it today would not be possible. 
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The transistor was invented in 1947 but did not see widespread use in computers until the late 
50s. The transistor was far superior to the vacuum tube, allowing computers to become 
smaller, faster, cheaper, more energy-efficient and more reliable than their first-generation 
predecessors. Though the transistor still generated a great deal of heat that subjected the 
computer to damage, it was a vast improvement over the vacuum tube. Second-generation 
computers still relied on punched cards for input and printouts for output. 

Second-generation computers moved from cryptic binary machine language to symbolic, or 
assembly, languages, which allowed programmers to specify instructions in words. High-
level programming languages were also being developed at this time, such as early versions 
of COBOL and FORTRAN. These were also the first computers that stored their instructions 
in their memory, which moved from a magnetic drum to magnetic core technology. The first 
computers of this generation were developed for the atomic energy industry. 

IMPORTANT MACHINES: 

IBM 7074 series, CDC 164, IBM 1400 Series. 

ADVANTAGES: 

1. If we compare it with G1 computer, less expensive and smaller in size. 
2. Fast in speed 
3. Less head generated as G1 computers generate more. 
4. Need low power consumption 
5. Language after machine language for programming, in G2 assembly language 

(COBOL, FORTRON) is introduced for programming. 
6. Portable. 

 

DISADVANTAGES: 
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1. Maintenance of machine is required. 
2. Air conditioning required still as heat causes to process slowly. 
3. These computers are not used as personal system.  
4. Preferably used for commercial purposes 

 

 

THIRD GENERATION (1964 - 1975) 

 

The development of the Integrated Circuit was the hallmark of the third generation of 
computers. Transistors were miniaturized and placed on silicon chips, called semiconductors, 
which drastically increased the speed and efficiency of computers.  

Instead of punched cards and printouts, users interacted with third generation computers 
through keyboards and monitors and interfaced with an operating system, which allowed the 
device to run many different applications at one time with a central program that monitored 
the memory. Computers for the first time became accessible to a mass audience because they 

were 
smaller 
and 
cheaper 
than their 
predecesso
rs.  

  

 

 

 

 

 

IMPORTANT MACHINES: 

IBM System/360 & IBM 370, PDP-8, DEC, UNIVAC 1108, UNIVAC 9000. 
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ADVANTAGES: 

1. Smaller in size 
2. Low cost then previous 
3. Low power consumption 
4. Easy to operate  
5. Portable 
6. Input devices introduced and that make user easy to interact with it like keyboard, 

mouse etc 
7. External Storage medium introduced like floppy & tape. 

 

DISADVANTAGES: 

1. IC chips are still difficult to maintain 
2. Need complex technology. 

FOURTH GENERATION (1975 ONWARDS) 
 

The Microprocessor brought the fourth generation of computers, as thousands of integrated 
circuits were built onto a single silicon chip. What in the first generation filled an entire room 
could now fit in the palm of the hand.  

The Intel 4004 chip, developed in 1971, located all the components of the computer—from 
the central processing unit and memory to input/output controls—on a single chip.  

In 1981 IBM introduced its first computer for the home user, and in 1984 Apple introduced 
the Macintosh. Microprocessors also moved out of the realm of desktop computers  

and into many areas of life as more and more everyday products began to use 
microprocessors.  

As these small computers became more powerful, they could be linked together to form 
networks , which eventually led to the development of the Internet. Fourth generation 
computers also saw the development of GUIs, the mouse and handheld devices. 
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IMPORTANT MACHINES: 

Intel processors, AMD processor based machines 

ADVANTAGES: 

1. Smaller in size 
2. High processing speed 
3. Very reliable 
4. For general purpose 
5. More external storage mediums are introduced like CD-ROM, DVD-ROM. 
6. GUIs developed for interaction 

 

FIFTTH GENERATION (1980 ONWARDS) 
 

Fifth generation computing devices, based on Artificial Intelligence, are still in 
development, though there are some applications, such as voice recognition, that are being 
used today.  

The use of parallel processing and superconductors is helping to make artificial intelligence a 
reality. Quantum computation and molecular and nanotechnology will radically change the 
face of computers in years to come.  

The goal of fifth-generation computing is to develop devices that respond to natural language 
input and are capable of learning and self-organization. 
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IMPORTANT MACHINES: 

ULAIC Technology, Artificial intelligence etc 

PROPERTIES 

1. Program independent 
2. Have thinking and analysis by its own 
3. Voice reorganization & biometric devices 
4. Self organization and learning 
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Chapter No 7 

TYPES OF COMPUTER 
 

The computer sitting on the desk in your classroom is a microcomputer. It is a small, 
powerful piece of equipment. Even so, the power of the microcomputer is not enough for 
most large organizations. The computer industry consists of more than just microcomputers. 

Any classification of computers is somewhat arbitrary. Computer can be classified it to 
following basis defined below. 

 On the basis of functionality 
 On the basis of Size, Speed and Cost. 
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ON THE BASIS OF FUNCTIONALITY: 

According to functionality computer can be divided in to three types: 

1. Analog 
2. Digital 
3. Hybrid 

ANALOG COMPUTERS: 

DEFINITION: 

 “An analog (spelled analogue in British English) computer is a form of computer that 
uses the continuously-changeable aspects of physical fact such as electrical, 
mechanical, or hydraulic quantities to model the problem being solved.” 

 Analog means continuity of associated quantity just like an analog clock measures 
time by means of the distance traveled by the hand of the clock around a dial.  

 
HISTORY: 

Mechanical analog computers were very important in gun fire control in World War II and 
the Korean War; they were made in significant numbers. In particular, development of 
transistors made electronic analog computers practical, and before digital computers had 
developed sufficiently, they were commonly used in science and industry. 

 

 

 

 

 

 

 

 

EXAMPLES:  

 Thermometer 
 Analog clock 
 Speedometer  
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 Tire pressure gauge 

ADVANTAGES: 

 Analog computer has come to refer to 
o  devices and media that represent 
o Store images 
o Sound, motion pictures, etc.  

DISADVANTAGES:  

 Analog computers can have a very wide range of complexity.  
 Slide rules and monographs are the simplest, while naval gun fire control computers 

and large hybrid digital/analogue computers were among the most complicated.  
 Very complicated for containing output for the users some time. 

DIGITAL COMPUTERS: 

DEFINITION: 

 “A computer that performs calculations and logical operations with quantities 
represented as digits, usually in the binary number system of “0” and “1”. 

 “Computer capable of solving problems by processing information expressed in 
discrete form. By manipulating combinations of binary digits (“0”, “1”), it can 
perform mathematical calculations, organize and analyze data, control industrial and 
other processes, and simulate dynamic systems such as global weather patterns. ” 

 

 

 

 

 

 

 

 

 

HISTORY: 

In 1937 at Bell Labs, George Stibitz invented the first calculator based on binary circuits to 
perform complex mathematical formulas. 
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Steinitz’s invention transformed computer science from analog to digital. With the advent of 
digital technology, scientists could customize a computer's operating functions by developing 
programming languages.  
 
EXAMPLES:  

 IBM PC 
 Apple Macintosh  
 Calculators 
 Digital watches etc 

HYBRID COMPUTERS: 

DEFINITION: 

 “A computer that processes both analog and digital data”. 
 “Hybrid computer is a digital computer that accepts analog signals, converts them to 

digital and processes them in digital form” 

A hybrid computer may use or produce analog data or digital data. It accepts a continuously 
varying input, which is then converted into a set of discrete values for digital processing.  

Examples: 

 Hybrid computer is the computer used in hospitals to 
measure the heartbeat of the patient. 

 Devices used in petrol pump. 
 Hybrid Machines are generally used in scientific 

applications or in controlling industrial processes. 

 

 

 

 

 

ON THE BASIS OF SIZE, SPEED AND COST: 

We can divide computers on the basis of size cost and speed as: 

 Super Computer 
 Mainframe Computer 
 Mini Computer 
 Micro Computer 
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 Personal Computer 
o Desktop computers 
o Laptop /Note Books 

 Mobile Computer & Devices 
o PDA 
o Tablet PC 
o Hand Held Computer 
o Laptop/Note Books 

SUPER COMPUTER 

Supercomputers are the largest, fastest, most powerful, and most expensive computers 
made. Like other large systems, supercomputers can be accessed by many individuals at the 
same time. Supercomputers are used primarily for scientific applications that are 
mathematically intensive. The first supercomputer was built in the 1960s for the United 
States Department of Defense.  

This computer was designed to be the world's fastest and most powerful computer of that 
time. The commitment to create the fastest, most powerful computer in the world is still the 
driving force behind the development of supercomputers. Manufacturers produce relatively 
few of any one model of supercomputer, and they spend millions of dollars on research and 
development of new machines. 
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Supercomputers derive much of their speed from the use of multiple processors. 
Multiprocessing enables the computers to perform tasks simultaneously--either assigning 
different tasks to each processing unit or dividing a complex task among several processing 
units. 

EXAMPLE: 

 Cray-1 

 Cray-2 

 Control Data Cyber 205 

 ETA 

 

FEATURES: 

 The aerospace, automotive, chemical, electronics and petroleum industries use 
supercomputers extensively.  

 Supercomputers are used in weather forecasting and seismic analysis. They are found 
in many public and private research centers, such as universities and government 
laboratories. 

 A supercomputer was used to alert scientists to the impending collision of a comet 
with Jupiter in 1994, giving them time to prepare to observe and record the event.  

 The ultra supercomputer will simulate nuclear explosions (eliminating the need to 
detonate any bombs), model global weather trends, and design power plants. 

 Supercomputers can perform at up to 128 gigaflops, and use bus widths of 32 or 64 
bits. This capability makes supercomputers suitable for processor-intensive 
applications, such as graphics. 

Note:  

The speed of modern supercomputers is measured in nanoseconds and gigaflop. A 
nanosecond is one billionth of a second. A gigaflop is one billion floating-point arithmetic 
operations per second.  
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MAINFRAME COMPUTER 

Mainframe computers are the most powerful computers. A mainframe computer may contain 
several microprocessors. A single mainframe computer can be used by hundreds of people at 
once.  

Each user has his own terminal that is connected to the mainframe. Mainframe computers 
are usually kept in a special cooled, clean computer room. Minicomputers are medium-sized 
computers which are more powerful than microcomputers but not as powerful as mainframes.  

A mainframe computer system is usually composed of several computers in addition to the 
mainframe, or host processor. 

Host Processor: 

 The host processor is responsible for controlling the other processors, all the peripheral 
devices, and the mathematics operations.  

Front End processor: 

A front-end processor is responsible for handling communications to and from all the remote 
terminals connected to the computer system.  

Back end Processor: 

Sometimes a back-end processor is used to handle data retrieval operations. Although the 
host computer could perform all these operations, it can be used more efficiently if relieved 
of time-consuming chores that do not require processing speed.  
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FEATURES:  

 Mainframe computer systems are powerful enough to support several hundred users 
simultaneously at remote terminals.  

 Mainframe Computers are so much faster than people, the users never notice that the 
computer is handling other tasks.  

 This capability to process many programs concurrently for multiple users is known as 
multiprogramming.  

 The typical mainframe computer occupies much of a large room.  

 Like supercomputers, mainframes require an environment with closely monitored 
humidity and temperature.  

 Mainframe computers are priced between $100,000 and $2,000,000. 
 

EXAMPLE: 

 IBM S/390 

 Amdahl 580 

 Control Data Cyber 176 
 

MINI COMPUTER 

The "age of the mini" started in the late 1960s. The creation of integrated circuits suitable for 
computers enabled designers to shrink the size of the computer. Minicomputers are 
frequently referred to as mid-range computers. 
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Before Digital Equipment Corporation (DEC) released the first DEC PDP-8 minicomputer 
in 1968, most medium-sized organizations were priced out of the computer market because 
they couldn't afford mainframe computers. 

 

FEACTURES: 

 Like mainframes, most minicomputers are multiuser systems.  

 Many of today's minicomputers can accommodate as many as 200 users working 
from individual terminals.  

 Mini computers are a little slower than mainframe. 

 Like mainframes, minicomputers can accommodate remote users, but not as many. 

 Minicomputers' input, output, and storage devices look like those on mainframes. 

 Minicomputers have slightly less storage, and the printers are slightly slower.  
 

EXAMPLE: 

 IBM AS/400 

 IBM SYSTEM 360 

 HP 3000 

 PRIME 9755 

MICROCOMPUTER 

When you are working on a multiuser computer, such as a mainframe or minicomputer, you 
can control the input and see the output on the display, but you control nothing else.  

A single-user computer gives you control over all the phases of computer processing: input, 
processing, output, and storage. You can select the programs you want to use, and you don't 
have to compete with other users to gain access to the system. A single-user system is 
designed to meet the computing needs of an individual.  

Single-user computers fall into two categories: 

 Workstations 
 Microcomputers.  
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WORKSTATION: 

A workstation is a powerful desktop computer designed to meet the computing needs of 
engineers, architects, and other professionals who need detailed graphics displays. The 
workstation has sometimes been called a "super micro." The workstation looks very much 
like a desktop microcomputer, but the chips inside make the difference 

For example, workstations are commonly used for computer-aided design (CAD), in which 
industrial designers create pictures of technical parts or assemblies. To process these complex 
and detailed diagrams, the computer needs great processing power and much storage.  

FEATURES: 

 Workstations are small, powerful systems designed to drive networks of less powerful 
microcomputers and to create high-quality graphics.  

 Workstations typically cost $5,000 to $20,000.  

 Major competitors in this market include DEC, Hewlett-Packard, Sun, and Silicon 
Graphics, Inc. 

MICROCOMPUTERS: 

It is difficult to overstate the impact of the microcomputer on the computer industry. In 1975, 
the microcomputer did not exist. In 1995, sales exceeded $116 billion. Microcomputers are 
the fastest growing segment of the computer industry.  

The microcomputer segment of the industry is complex; there are different types of 
microcomputer platforms with varying capabilities. The most common type of 
microcomputer is a desktop computer, which is a non portable personal computer that fits 
on top of a desk. (will describe below). 

Microcomputers are the smallest and cheapest of these and are used at home, in schools and 
in some businesses. Mainframe computers are the most powerful computers 
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This table makes some comparisons between the different types of computer: 

Comparison Microcomputer Minicomputer Mainframe 

Where Used 

Home, small 
business, on a 
network in a 
larger business. 

Medium sized 
business. e.g. 
supermarket, 
traffic control 
system. 

Large 
businesses, 
universities.  

Number of 
Users

1 1 - 20 Hundreds 

Cost 
30,000 – 200,000 
Rs 

25,000-100,00 
Rs 

Rs 
2,000,000+ 

 

PERSONAL COMPUTER 

DEFINATION: 

“A small computer, intended for use by an individual. A personal computer will usually fit on 
a desk.” 

 A computer designed for use by a single user. Although other Microcomputers preceded it, 
the IBM PC was the first to use the name specifically. As a result, the term PC now applies to 
an IBM-compatible computer as contrasted to the Apple Macintosh, these being the two 
standards that emerged from an abundance of competitors in the early 1980s. 

PC further divided in to two types: 

 Desktop Computer 

 Laptop/ Note book Computer 

DESKTOP COMPUTER: 

DEFINATION: 

“A computer designed for desktop use; usually comprises, at a minimum, a central processing 
unit (CPU), a monitor, and a keyboard as separate units, connected by special cables. Most 
such computers now also include a Pointing Device. 
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A computer that could fit on a desk was considered remarkably small. Desktop computers 
come in a variety of types ranging from large vertical tower cases to small form factor models 
that can be tucked behind an LCD monitor. 

 "Desktop" can also indicate a horizontally-oriented computer case usually intended to have 
the display screen placed on top to save space on the desktop. Most modern desktop 
computers have separate screens and keyboards.  

 

 

 

 

 

 

 

LAPTOP /NOTE BOOK COMPUTER: 

DEFINATION: 

 “A laptop is a personal computer designed for mobile use, small and light enough to 
sit on a person's lap while in use.” 

 “A portable computer typically weighing less than 6 pounds (3 kilograms) that has a 
flat-panel display and miniature hard disk drives, and is powered by rechargeable 
batteries.” 

Laptops are capable of many of the same tasks that desktop computers perform, although 
they are typically less powerful. Laptops contain components that are similar to those in their 
desktop counterparts and perform the same functions but are miniaturized and optimized for 
mobile use and efficient power consumption. Laptops usually have LCD displays. 

Laptops generally cost around twice as much as a desktop machine of similar specification. 
Performance is always lower than that of a comparable desktop because of the compromises 
necessary to keep weight and power consumption low. 
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MOBILE COMPUTERS / DEVICES 

All devices which can carry in hand and portable, is said to be mobile devices and computers. 

These Devices are categorized in: 

 PDA 
 Tablet PC 
 Hand Held Computer 
 Laptop/Note Books 

PDA 

DEFINITION:  

PDA stands for “Personal Digital Assistant”. A small, handheld system combining in one 
device multiple computing, Internet, networking, and fax/telephone features”A PDA contain 
following features: 

 Keep phone directories  

 Calendars and provide calculator capabilities  

 Schedule appointments 

 Retrieve frequently used phone numbers 

 Jot down notes.  

 Most PDAs are designed to accept written input by a pen; the PDA decodes what you 
write. 
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TABLET PC 

DEFINATION: 

 “A tablet PC is a wireless personal computer (PC) that allows a user to take notes 
using natural handwriting with a stylus or digital pen on a touch screen.” 

 A tablet PC is similar in size and thickness to a yellow paper notepad and is intended to 
function as the user's primary personal computer as well as a note-taking device. 

 Tablet PCs generally have two formats, a convertible model with an integrated keyboard and 
display that rotates 180 degrees and can be folded down over the keyboard or a slate style, 
with a removable keyboard. 
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 The user's handwritten notes, which can be edited and revised, can also be indexed and 
searched or shared via e-mail or cell phone.  

 
 

 

 

 

 

 

 

 

HAND HELD COMPUTER 

DEFINITION 

 “Very small, lightweight device (such as the Palm Pilot) which provides functionality 
approaching that of a laptop computer. “ 

Features of modern handhelds include calendar and diary organizing, word processing, data 
management, remote access to firm's network, internet access, wireless access, messaging, etc 

 

 

 

 

 

 

 

 

LAPTOP/NOTE BOOKS COMPUTER 

DEFINATION: 
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 “A laptop is a personal computer designed for mobile use, small and light enough to 
sit on a person's lap while in use.” 

 “A portable computer typically weighing less than 6 pounds (3 kilograms) that has a 
flat-panel display and miniature hard disk drives, and is powered by rechargeable 
batteries.” 

Laptops are capable of many of the same tasks that desktop computers perform, although 
they are typically less powerful. Laptops contain components that are similar to those in their 
desktop counterparts and perform the same functions but are miniaturized and optimized for 
mobile use and efficient power consumption. Laptops usually have LCD displays. 
 

Laptops generally cost around twice as much as a desktop machine of similar specification. 
Performance is always lower than that of a comparable desktop because of the compromises 
necessary to keep weight and power consumption low. 
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Chapter No 8 

 

SOFTWARE AND PROGRAMING 
LANGUAGES 

 

SOFTWARE: 

DEFINITION: 

 “A piece of software is a computer program which has been written to carry out a 
particular task.” 

 “A set of instruction to solve a particular problem” 

Without software the hardware that is used to build a computer system would not be very useful. 
A software program contains the instructions that the computer must follow to carry out the task. 
Sometimes more than one program is required to complete a task. When this is the case the 
group of programs which together complete the task are known as a software package. 

Software programs are originally produced by computer programmers who will write the 
instructions that form the program in a programming language. 

Example pieces of software are: 

 A word processor.  

 A multimedia encyclopedia.  

 A spreadsheet.  

 

TYPES OF SOFTWARE  

A software is usually classified as being two types 

1. Systems software 
2. Applications software. 
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SYSTEM SOFTWARE 

 

Systems software controls the operation of a computer. Without systems software a computer 
would not function. The most important piece of systems software is the operating system. The 
operating system will perform vital tasks such as: 

 Managing communications between software and hardware.  

 Allocating computer memory to other software programs.  

 Allocating CPU time to other software programs.  
 

TYPES 

 Operation systems 
 Utility program 
 Programming languages 
 Device drivers 
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APPLICATION SOFTWARE 

 

DEFINATION: 

“Application software consists of programs designed to perform specific tasks for users”. 

 Application software can be used as a productivity/business tool; to assist with graphics and 
multimedia projects; to support home, personal, and educational activities; and to facilitate 
communications. 

TYPES: 

 Word Processor   
 Presentation Software 
 Database 
 Spreadsheet 
 Communication software 
 Desktop Publisher 
 Graphics Package 

 



Chapter No 9:  SYSTEM SOFTWARE 

96 
 

fCHAPTER NO 9  

 

SYETEM SOFTWARE 
DEFINATION: 

Systems software controls the operation of a computer. Without systems software a computer 
would not function. The most important piece of systems software is the operating system. 
The operating system will perform vital tasks such as: 

 Managing communications between software and hardware.  

 Allocating computer memory to other software programs.  

 Allocating CPU time to other software programs.  

 
EXAMPLES: 

 Operation systems 
 Utility program 
 Programming languages 
 Device drivers 
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OPERATING SYSTEM 

The operating system is a very special piece of software. All the other applications software 
such as databases and spreadsheets communicate with the computer hardware through the 
operating system. The operating system controls the overall operation of the computer. 

DEFINITION: 

“An operating system (or OS) is a computer program which controls the entire operation of 
the computer. Computer software applications communicate with the computer hardware via 
the operating system”. 

Example Operating Systems 

When you buy a computer it is usually supplied with an operating system already installed. 
You will not be able to use a computer without an operating system. Different operating 
systems are available for different types of computer and different purposes. Some popular 
operating systems are: 

 

 Microsoft windows  
 Disk Operating System (DOS) 
 Linux 
 Unix 

 

The choice of operating system will affect how a computer works. It will probably determine 
the type of user interface (command line, menu driven or graphical) that the computer uses 
and the types of processing (batch, transaction or real-time) that the computer can carry out. 
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COMMAND LINE INTERFACE: 
 

Command Line Interface (CLI) lets you control your PC by typing commands. In the figure 
below is command line interface. There's no mouse or graphical controls like you get in a 
GUI such as Windows. 

 

 
 

 

 

 

 

 

 

GRAPHICAL USER INTERFACE (GUI): 

“A graphical user interface (GUI, pronounced "gooey") is a computer environment that 
simplifies the user's interaction with the computer by representing programs, commands, 
files, and other options as visual elements, such as icons, pull-down menus, buttons, scroll 
bars, windows, and dialog boxes.”  

By selecting one of these graphical elements, through either use of a mouse or a selection 
from a menu, the user can initiate different activities, such as starting a program or printing a 
document 

As define in that figure: 
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TASKS PERFORMED BY AN OPERATING SYSTEM 

There are several tasks which are performed by practically all operating systems, regardless 
of the complexity of the computer the operating system is being used on. These tasks include: 

1. Managing communications between software and hardware.  
2. Allocation of computer memory.  
3. Allocation of CPU time.  
4. Run and Manage program 
5. Managing files 
6. Configure Software and Devices 
7. Configure Network 
8. Coordinating Tasks 
9. Performance Management 

 

The range of tasks that an operating system performs increases if the computer using the 
operating system is on a network or if the operating system is a multi-tasking or multi-user 
operating system. 

1) MANAGING COMMUNICATIONS BETWEEN SOFTWARE AND 
HARDWARE 

There are many tasks which practically every program written for a computer will need to 
carry out. For example: 

 Loading and saving data and programs.  
 Communicating with peripherals such as a mouse or a printer.  
 Organizing data stored on a hard disk.  
 Displaying information on the VDU.  

Therefore the operating system manages all of these tasks. If, for example, a program 
wants to save or print a file it must send a request to the operating system asking it to do 
so. The operating system will then carry out the task. 

Because an application such as a spreadsheet works by communicating with the operating 
system the application will probably only work with one particular operating system. If 
you buy Microsoft Works for Windows 95 it will only operate on computers with the 
Windows 95 operating system. If you want to use Microsoft Works with the MS-DOS 
operating system you will have to buy a different version of the application. 
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Putting commonly used operations such as saving data into the operating system also 
reduces the amount of work that a person writing a new application must do. 

 

2) ALLOCATION OF COMPUTER MEMORY 

Computer memory must be allocated to (divided between) the different tasks that the 
computer is performing. Even if your computer appears to be doing only one task such as 
word processing there will be several different items to which memory must be allocated.  

For example memory would have to be allocated to storing the word processor program, 
storing your word processed document and storing a copy of the screen that is being 
displayed on the monitor. And of course the operating system itself will also use up some 
memory. 
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3) ALLOCATION OF CPU TIME 

Most computers have only one Central Processing Unit (CPU) or microprocessor. The 
CPU can only process one piece of data at a time. Therefore the CPU’s time must be 
divided up between all of the tasks that the computer is currently carrying out. If you 
were printing a document form a word processor application then the CPU’s time would 
need to be divided up between: 

 Letting you type on the computer.  
 Sending the document that is being printed to the printer.  
 Updating the screen display to show you what is going on.  

4) RUN AND MANAGE PROGRAM 

The operating system manages all the other programs that run on the computer. The 
operating system provides services to programs and the user, including file management, 
memory management, and printing. It provides services to programs, the OS makes 
system call requesting other hardware and software resources to perform tasks. 
  

5) MANAGE FILES 

Operating system manages and organizes all files in system. The operating system keeps 
track of all the files on each disk. Users can make file management easier by creating a 
hierarchical file system that includes folders and subfolders arranged in a logical order. 
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6) CONFIGURE SOFTWARE AND HARDWARE 
 

Operating system is maintaining organized communication with the process and 
hardware.  Each hardware device is controlled by Software, which allows the OS to 
activate and use the device. The operating system provides the software and hardware 
connection in order to use that hardware. 

 

 

 

 

 

 

 

OPERATING SYSTEM 
HARDWARE  SOFTWARE 
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7) CONFIGURE NETWORK 

Operating system manages and configures network and internet connections it provide the 
platform on which computer networking takes place. Operating system provide basic 
features for allow for file, print and Internet connections.  

OS configured and managed through network operating system utility. 
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8) COORDINATING TASKS 
 
Operating system controls the order and time in which programs are run and is more 
difficult in the mainframe environment where scheduling the daily work has always 
been routine. In a desktop environment, batch files can be written to perform a 
sequence of operations that can be scheduled to start at a given time.  
 
Multitasking, which is the ability to simultaneously execute multiple programs, is 
available in all operating systems today. Multitasking is necessary for keeping several 
applications open at the same time so you can bounce back and forth among them 
 
 
 

9) PERFORMANCE MANAGMENT 

Operating system given the increased complexity of processors and applications, the current 
generation of Operating Systems (OSs) focuses mostly on software integrity.  

Operating System managed with performance by resource partitioning (virtualization), 
CPU cycles, clock speed, memory and I/O bandwidth, and main/cache memory space. 
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TYPE OF OPERATING SYSTEM 

An operating system is a software component of a computer system that is responsible for the 
management of various activities of the computer and the sharing of computer resources.  

Users and application programs access the services offered by the operating systems, by 
means of system calls and application programming interfaces. Users interact with operating 
systems through Command Line Interfaces (CLIs) or Graphical User Interfaces known as 
GUIs as defined above.  

In short, operating system enables user interaction with computer systems by acting as an 
interface between users or application programs and the computer hardware.  

The types of Operating systems are here under: 
 

1) Single user/personal computer operating system 
2) Multiuser/network operating system 
3) Embedded operating system 

 

1) SINGLE USER/PERSONAL COMPUTER SOPERATING 
SYSTEM: 

The most basic type of operating system can only carry out one task at a time and can only be 
used by one person at a time. More sophisticated multi-tasking and multi-user operating 
systems can appear to carry out more than one task and be used by more than one user at the 
same time. 
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It has further types 

 DOS 
 MAC OS 
 Windows 

DISK OPERATING SYSTEM (DOS): 
 

DOS stands for “Disk Operating System”. It is single user operating user has command line 
interface. DOS is product of Microsoft but developed for another company named as IBM.  

DOS uses a command line, or text-based interface, that allows the user to type commands. By 
typing simple instructions such as pwd (print working directory) and cd (change directory), 
the user can browse the files on the hard drive, open files, and run programs. While the 
commands are simple to type, the user must know the basic commands in order to use DOS 
effectively. 

 

 
 

 

 

 

MAC OPERATING SYSTEM: 
 

Mac OS X is Apple's operating system for its line of Macintosh computers. Its interface, 
known as Aqua, is built on a Unix foundation.  

it has much of the look and feel of the former Mac OS, features such as preemptive 
multitasking, symmetric multiprocessing, multithreading, and protected memory give Mac 
OS X improved stability and performance. 
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WINDOWS OPERATING SYSTEM: 
 

Windows is a personal computer operating system from Microsoft. Operating system 
designed and produced by Microsoft Corporation. Similar to other operating systems, 
Windows makes a computer system user-friendly by providing a graphical display and 
organizing information so that it can be easily accessed. 

The operating system utilizes icons and tools that simplify the complex operations performed 
by computers. Estimates suggest that 90% of personal computers use the Windows operating 
system. Microsoft introduced the operating system in 1985 and it has continued to be widely 
used despite competition from Apple's Macintosh operating system. 

It has many versions like 

 Windows 95 

 Windows 2000 

 Windows 2000 XP 

 Windows vista 

 Windows 7 

 Windows me 
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2) MULTIPLE USER/NETWORK OPERATING SYSTEM: 

Multi-user operating systems are used on large mainframe computers. A mainframe computer 
system has one very powerful processing unit. Many users will all share this processing unit. 
They use terminals (a keyboard and a screen) to access the mainframe computer. 

A multi-user operating system lets more than one user work on a mainframe computer at the 
same time. 

 

 

 

 

 

 

 

 

 

 

Operating systems that are used on computers connected to networks usually have to carry 
out some additional tasks. Probably the most important of these is managing system security. 
Important aspects of systems security that an operating system might manage are : 

 Controlling who has access to which files.  
 Keeping a log of all of the files that a user changes.  
 Automatically backing up important files.  

These operating systems are more complicated and require faster hardware and more memory 
to work than more basic operating systems. 

It has further types 

 WINDOWS NT SERVER 
 WINDOWS 2000 SERVER 
 UNIX 
 SOLARIS/LINUX 
 NOVEL’S Novell’s  
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WINDOWS NT SERVER: 
 

Windows NT is a Microsoft Windows personal computer operating system designed for users 
and businesses needing advanced capability. 

 NT's technology is the base for the Microsoft successor operating system, Windows 2000. 
Windows NT (which may originally have stood for "New Technology”, is actually two 
products: Microsoft NT Workstation and Microsoft NT Server.   

 

 

 

 

 

 

 

 

 

WINDOWS 2000 SERVER: 
 

Window 2000 server is also product of “Microsoft” and advance version of Windows NT 
server. It is designed to appeal to small business and professional users as well as to the more 
technical and larger business market. It is consist of three products 

 Windows 2000 server 

 Windows 2000 Advance server 

 Windows 2000 data center server 
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UNIX: 
 

By the simplest definition, UNIX is a computer operating system - the base software 
that controls a computer system and its peripherals. In this sense, UNIX behaves in the 
same way that the perhaps more familiar PC operating systems 

UNIX is a powerful, flexible, computer operating system designed for multi-user 
applications (such as networks). It is the most frequently used operating system for 
servers on the World Wide Web. 

 

 

 

 

 

 

SOLARIS/LINUX: 
 

The Solaris Operating System (Solaris OS) is another version of UNIX. Solaris is the 

computer operating system that Sun Microsystems for Intel-based processors.  

Sun has historically dominated the large UNIX workstation market. As the Internet grew in 

the early 1990s, Solaris systems became the most widely installed servers for Web sites. 

Solaris has its large number of features, and its Internet-oriented design.  
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NOVELL’s NETWARE: 
 

A family of network operating systems from Novell that support Windows, Macintosh, DOS 
and OS/2 clients. UNIX client support is available from third parties.  

In the early 1990s, NetWare was the largest installed base of LAN operating systems. It 
eventually gave way to UNIX, Linux, Windows and Mac running the IP protocol. 

NetWare, made by Novell, is a widely-installed network server operating system. Initially 
very successful in installing its products in large and small office local area networks 
(LANs), Novell redesigned (or at least re- featured) NetWare to work successfully as part of 
larger and heterogeneous networks, including the Internet. An early - and primary competitor 
was the Microsoft Windows NT operating system. 

 

 

  

 

 

 

 

 

 

3) EMBEDDED OPERATING SYSTEM 

 

An embedded operating system is an operating system for embedded computer systems. Due 
to the very nature of embedded systems, the operating system has different constraints 
compared to other desktop OS. 

These devices have operating system in ROM. Many handheld devices have the embedded 
operation systems like PDA, palm device, tablet pc etc 
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Types of embedded OS are here under: 

 Windows Embedded CE 

 Windows mobile 

 Palm operating system 

 I phone OS  

 Black berry Operating System 

WINDOWS EMBEDDED CE 

This operating system is designed for some portable and web based devices which have 
different features like Communication, internet, entertainment & different application 
programs like MS Word & Excel etc 

It has many features like other operating system which is designed by Microsoft like for 
entertainment it has windows media player, we can perform multitasking in these devices. 
We can check email and browse websites. 

 

 

 

 

 

 

 

 

 

WINDOWS MOBILE 

This operating system is same like Windows CE but it is specially designed for some PDA 
(Personal Digital Assistant) and other mobile devices.  

It has same features like Windows CE but by windows mobile any user can access its 
contacts from address book, schedule his tasks and set the notes and meetings on it.  
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PALM OPERATING SYSTEM 

This operating system is  designed for some devices which we can hold in hand and portable.  

Palm operating system that provides a software platform for the Palm series of handheld 
personal digital assistants (PDAs) made by Palm Inc. According to Palm, Palm OS was 
designed from the beginning to fit into a palm-size device of a specific size and with a 
specific display size. 

Palm OS has Dates, Address Book, To Do Lis, Memo Pad, Calculator, and special Password 
Protection. 

 

 

 

 

 

 

 

I PHONE OPERATING SYSTEM 

This is designed for special based devices which have capability to work with touch screen 
and touch pad, I phone and I Pad Touch. By the help of your fingers all objects can 
functioned. 
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The I Phone Touch has the same applications that are present by default on the other PDAs 
but, with the exception of the Phone, Messages, Compass and Camera apps. It also has two 
applications of Music, and Videos.  

 

 

 

 

 

 

 

 

BLACK BERRY OPERATING SYSTEM 

It is designed for a handheld device named as black berry.  That operating system provides 
web capabilities like email, chatting, text messages, multimedia massages and can access 
different remote devices with Blue tooth technology. It also provide interface to take pictures, 
record videos and has GPS (Global positioning system). 
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UTILITY PROGRAM 

A program that performs a specific task related to the management of computer functions, 
resources, or files, as password protection, memory management, virus protection, and file 
compression. 

It is part that is used to provide services for the hardware and software but it is not absolutely 
required to run programs and, if it didn't come with the operating system, you could perhaps 
add it. In other usages, a utility is an application that is very specialized and relatively limited 
in capability. 

Examples of some utilities are here under: 

 Virus scanning software 
 Backup software 
 Scandisk 
 Disk defragmenter  

 

VIRUS SCANNING SOFTWARE 
 
 Virus Scanning Software is utility programs designed to protect your computer from 
computer viruses. Virus scanning software is critical to uses, due to the number of computer 
viruses (small computer programs created to disrupt and destroy computer files and/or 
operating system software). 

Virus scanning software scans your disk each time you insert it into a computer. If you 
receive a warning that there is a virus suspected on your disk then to eliminate the virus we 
have antivirus utility. If you own your own computer, you should have a good virus scanning 
software package installed. Remember - virus scanning software needs to be updated on a 
regular basis (usually monthly). Updates insure that your virus scanning software will protect 
you from the most recent viruses. Virus scanning packages come with directions on how to 
receive updates to your software. Some popular anti 
viruses are: 

1. MacAfee 
2. Avaira 
3. Norton 
4. Symantec 
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BACKUP SOFTWARE 

Backup software is software that assists you in backing up your files and even the entire 
computer hard drive. It is important for you to back up your files regularly. If you own your 
own computer, you should think about how to backup your valuable data on your hard drive, 
USB, and server. The server that houses your Home Folder is backed up regularly. 

 

 

 

 

 

SCANDISK 

Scandisk is a utility provided with Windows computers. Scandisk scans your disks to see if 
there are any potential problems on the disk, such as bad disk areas. Since disks are magnetic 
media, all disks, including your hard drive can be corrupted.  
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DISK DEFRAGMENTER SOFTWARE 

Disk Defragmenter software assists you in keeps reorganizing your disk drives. After files are 
saved, deleted and resaved again, the disk can become fragmented --- available space is in 
small blocks located throughout the disk. Disk defragmenters gather those free spots and put 
them together to enable you to continue to save your data in the most efficient manner. 

 

 

 

. 
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PROGRAMING LANGUAGES 

A language in simple word is a way of communication for any person to other person in order 
to understand his talk. 

 

 

 

 

 

 

 

Like in the picture above a girl is communicating, the man who is sitting next to her. So the 
language is very important medium of communication like linguistics of human. Like human 
languages, each programming language has its own grammar and syntax. There are many 
components of the same language Computer also need a language so that it can communicate 
to the hardware and other important components of computer. 

Definition: 

A language used to write instructions for the computer. That is the way of representation any 
program in to that form which is understandable by CPU. 

Reminder: program is written instruction for computer. 

Programs are written by using any language and these languages set the procedures & rules to 
write computer programs. Programmers have to follow that rules which is set by 
programming languages.  

TYPES OF PROGRAMMING LANGUAGES 

According to structure, interface and procedure computer languages can be divided in to two 
major types. 

1. Low Level Language 
2. High Level Language 
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1) LOW LEVEL LANGUAGE 

Low level language is also called machine language. That types of languages are close to 
machine and easily understand by machine as, it is majorly in binary form (0 & 1).low level 
language types are 

 Machine language 

 Assembly language 

MACHINE LANGUAGE 

This program written is this type of language sometimes referred to as machine code or 
object code, machine language is a collection of binary digits or bits that the computer reads 
and interprets. Machine language is the only language a computer is capable of 
understanding. Machine code is consisting of 0 & 1. Which mean off and on bit.  

Program written in machine language is very fast but machine dependent. It is also referred as 
“First Generation Language”. 

 

 

              Machine code 

 

 

  

ASSAMBLY LANGUAGE 

Assemble language is also low level language close to machine language. It is also referred as 
assembly or ASL, assembly language and “Second Generation Language”.  

 

 

 

           Assembly language
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Assembly language used to interface with computer hardware. Assembly language uses 
structured commands as substitutions for numbers allowing humans to read the code more 
easily than looking at binary. Although easier to read than binary, assembly language is still a 
complex language  

2) HIGH LEVEL LANGUAGE 

 

High level programming languages is languages program than use languages or syntax which 
closes to human languages so; it is easy to understanding the languages. This type of 
language is machine-independent, and uses similar language as English, which is easily 
understandable by human. 

 

                                                                                              

 

 

 

 

 

 

 

 

 

 

this type of language’s processing is slow as compared to high level languages. As, it need 
any translator between interface on computer and human. So, that both can understand their 
languages. 

 

TYPES OF HIGH LEVEL LANGUGES 

Types of high level languages are: 

 Procedural Languages 

TRANSLATOR 
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 Functional & Non procedural Languages 

 Object Oriented Languages 

PROCEDURAL LANGUGES 

 

The most common high-level languages today are procedure-oriented languages. In these 
languages, one or more related blocks of statements that perform some complete function are 
grouped together into a program module & procedure. These types of languages are “Third-
Generation Language”. 

The programmer defines the set of executable instructions and the exact sequence in which 
those instructions are to be executed. The computer simply obeys the instructions in the 
sequence it is told. 

Procedural languages allow programs to be shorter and easier for the computer to read, but 
they require the programmer to design each. 

Here are some types of procedural programming languages: 

 FORTRAN (FORmula TRANslation) 

 BASIC (Beginners All Purpose Symbolic Instruction Code) 

 COBOL (Common Business Oriented Language)  

 

NON PROCEDURAL LANGUGES 

In non-procedural languages the computer is not limited to a set of precise instructions. 
Instead, the programmer defines only the problem--not the instructions--to solve the problem. 

The computer determines the necessary steps to solve the problem. In essence, non-
procedural languages emphasize the result (or what) is to be achieved rather than the methods 
(or how) a result is achieved. For example, to sort a list, the programmer instructs the 
computer to output a list in which adjacent items are in increasing or decreasing order. 

 

Here are some types of Non Procedural Programming Languages: 

 SQL (Structured Query Language) 

 LISP (List Processing) 

 PROLOG (PROgramming with LOGic)  

 

 



Chapter No 9:  SYSTEM SOFTWARE 

124 
 

 

 

OBJECT ORIENTED LANGUGES 

Object-oriented languages are outgrowths of functional languages. In object-oriented 
languages, the code used to write the program and the data processed by the program are 
grouped together into units called objects. Objects are further grouped into classes, which 
define the attributes objects must have. 

A simple example of a class is the class Book. Objects within this class might be Novel and 
Short Story.  

 

 

 

 

 

 

 

 

 

LANUAGE PROCESSOR 

As, computer can understand only machine language; that’s why we need an interface 
between user and computer so that both can understand its instructions. 

                                                                                              

 

 

 

 

 

BOOK 

NOVEL BOOK 

STORY BOOK 

TRANSLATOR 
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Some types of language processors and translator are here under 

 Compiler 

 Interpreter 

 Assembler 

COMPILER 

A compiler is a computer program that transforms human readable complete code of another 
computer program into the machine readable code that a CPU can execute.  
 

INTERPRETER 

An interpreter is a computer program that reads the source code of another computer program 
and executes that program.  
Because it is interpreted line by line, it is a much slower way of running a program than one 
that has been compiled but is easier for learners because the program can be stopped, 
modified and rerun without time-consuming compiles. 

 

ASSEMBLER 

Assembler converts code written in assembly language into machine language. It works same 
like interpreter and compiler.  

The assembler program takes each program statement in the code and generates a 
corresponding bit stream or pattern (a series of 0's and 1's of a given length).  
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CHAPTER NO 10 

 

APPLICATION SOFTWARE 
 

DEFINATION: 

“Application software consists of programs designed to perform specific tasks for users”. 

 Application software can be used as a productivity/business tool; to assist with graphics and 
multimedia projects; to support home, personal, and educational activities; and to facilitate 
communications.  

Application software divided in to two main types 

 Custom based software 
 Package software 

CUSTOM BASED SOFTWARE: 

“The software which is specified by the software vendor/producer for a specific organization or 
institute is called custom based software” 

All organization which wants use custom software must buy a license for usage and Installation 
it in number of computers.  

Example:  

NADRA used special custom based software for registration of Pakistani nationals. 

GENERIC PACKAGED SOFTWARE: 

Generic software package is a package that can be put to a wide variety of uses. it is design for 
general public uses. For example a spreadsheet package can be used for any task involving 
calculations or graph plotting. The most common generic software packages are: 

1. Word Processor   
2. Presentation Software 
3. Database 
4. Spreadsheet 



Chapter No 10:  Application Software 

127 
 

5. Communication software 
6. Desktop Publisher 
7. Graphics Package 

 

WORD PROCESSOR   

“A word processing package is used to prepare and edit text.” 

 Word processors are used to create all types of documents such as letters, reports and essays. 
Using a word processor you can type, revise and correct a document on the screen before 
printing it out.  

The layout of the page can be changed and a wide variety of different styles of text can be used 
to improve the presentation of a document. Tools such as spelling checkers can help ensure that 
the contents of a document are accurate. 

The functions of a word processor can be divided up into several different categories: 

 Page Layout : The page layout functions let you decide how each page will be set out.  
 Text Presentation : The appearance of text can be easily altered. Different fonts and 

styles can be used and the size of text can be varied. Text can be neatly lined up on the 
page.  

 Editing of Text : Text editing functions are used to revise and change text that you have 
entered.  

 Blocks of Text: The style and position of selected blocks of text can be changed.  
 Text Analysis : The word processor can look at your document and try to highlight any 

errors such as spelling or grammatical mistakes that you have made.  
 Templates: Template files let you save favorite document layouts that you have created 

so that you can use them over and over again.  
 Other Features: Most modern word processors will offer lots of extra features such as 

tables, bullet points and fancy text effects.  
 Mail Merging : A database of names and addresses can be used to personalize letters that 

have been created in a word processor 
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PRESENTATION SOFTWARE   

“A software program for creating graphic presentations with visual aids, handouts, slides, etc. 
software for creating text with graphics, audio, and/or video; also called presentation graphics” 

 Presentation graphics: Presentation software sometimes called "presentation graphics". 
It is a category of application program used to create sequences of words and pictures 
that tell a story or help support a speech or public presentation of information.  

 Multimedia authoring tools: Presentation software can be divided into business 
presentation software and more general multimedia authoring tools, with some products 
having characteristics of both.  
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 Audio and video sequences:  Multimedia authoring software enables you to create a 
more sophisticated presentation that includes audio and video sequences. Business 
presentation software usually enables you to include images and sometimes audio and 
video developed with other tools. 
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DATABASE SOFTWARE 

“A database is a computerized record-keeping system. Databases are used when a large quantity 
of data has to be stored.” 

A database is very useful because it will provide tools to let the user search through the data that 
has been stored to find particular pieces of information. The data stored in a database must have 
a regular structure.  

A database will typically consist of one or more files storing information relevant to the 
organization that has created the database. Each file is identified by a filename. Sometimes a file 
in a database is known as a data table. 
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 For example a database keeping information for a doctors surgery may contain the following 
files: 

 

When you set up a database you decide on what files you want to create and what the structure of 
the records in the files should be. All the records in the same file must have the same structure. 
The structure of a record refers to the names of the fields that the record contains and the types 
of these fields. Databases are split up into separate files because: 

 Often you want to store information about different kinds of things (e.g. patients, 
employees) using different record structures. You need to use different files for the 
different structures.  

 Splitting up files can reduce data duplication, saving storage space and improving data 
consistency. 

SPREAD SHEET SOFTWARE 

A spreadsheet package is used for performing calculations and drawing charts. When you 
open a spreadsheet package the screen looks like a very large table similar to this: 

 

The table is divided into a number of boxes called Cells. You can type information into each 
cell. Going across the table are many Rows each of which is identified by a number. Going down 
the table are many Columns each of which is identified by a letter. 

Each cell is identified by a unique name called a Cell Reference. The cell reference is formed by 
writing down the letter of the column that the cell is in followed by the number of the row that it 
is in. 
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Groups of joined cells are known as a Range. A range can be described by writing down the cell 
references of the cells at the top left and bottom right corners of the range with a colon to 
separate them. 

You can enter three different types of information into a cell. The three types are : 

 Numbers: Any number.  
 Labels: Combinations of letters and numbers used as titles or labels to make the sheet 

clearer.  
 Formulas: Used to carry out calculations with the numbers that are entered into the 

sheet.  

 Formulas : Used to carry out calculations with the numbers that are entered into the 
sheet.  

 

DESKTOP PUBLICATION 

DTP stands for Desktop Publishing. You use DTP software to produce professional-looking 
documents such as reports, books, posters or leaflets. DTP software gives you more control 
over the layout of a page than a word processor and lets you easily integrate graphics into your 
publications. 
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 In addition to the features of a word processor you should also expect a desktop publisher to 
offer you these facilites : 

 Page Layout : The ability to define the layout of a page using frames to place text and 
pictures in.  

 Fonts and Styles : A wide range of fonts and styles.  
 Drawing Facilities : Some drawing facilities, although these may be limited.  
 Importing Pictures and Text : The ability to incorporate pictures and text from other 

packages into a document.  
 Clipart : A library of pictures for you to include in your documents.  
 Accurate Positioning : The ability to position objects extremely accurately on the page 

using guidelines or a grid.  

The main features that you can expect to find in a desktop publishing package are described in 
detail below 

 

GRAPHICS DESIGNING SOFTWARE 

Computer graphics or images are often used either by themselves or to enhance the quality of 
other documents, for example a desktop published document.  



Chapter No 10:  Application Software 

134 
 

 

There are three distinct types of package which can be used to create images on a computer. 
They are : 

 Painting Packages: This is the most basic type of graphics package. These packages 
allow you to paint onto the screen as if it was a canvas. Unfortunately they produce files 
which take up a lot of storage space and painted images are difficult to edit.  

 Drawing / Vector Drawing Packages: These are more sophisticated than painting 
packages. They store images as a set of objects which can be easily edited.  

 Computer Aided Design (CAD) Packages: Very advanced, highly accurate packages 
which can be used for designing three dimensional objects such as houses and machinery.  
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CHAPTER NO 11 

 

NETWORK AND INTERNET 

 

COMPUTER NETWORK 

DEFINATION:  

“A computer network is a group of computers which are connected together to allow 
communication between them.” 

 

TYPES OF NETWORK 

There are two main types of network : 

 LAN 
 WAN 

 

LOCAL AREA NETWORK (LAN) :  

Definition: “A network which is located entirely on one site such as an office, school or within a 
group of buildings that are in close proximity, that are connected together.”
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WIDE AREA NETWORK (WAN) : 

“A network which connects together computers on a number of sites in different areas”. 

A WAN or Wide Area Network is a group of widely dispersed computers that are connected 
together. These could be across the same town, or across a country or even across the world”. 

Apart from distance, the other feature that distinguishes as WAN from a LAN is that the WAN 
would make use of a range of communication technologies such as telephone, microwave and 
satellite links.  

Using a WAN, schools in Florida can communicate with places like Tokyo in a matter of 
minutes, without paying enormous phone bills. A WAN is complicated. 
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ADVANTAGES OF NETWORK 
 

 SPEED. 

Networks provide a very rapid method for sharing and transferring files. Without a network, files 
are shared by copying them to memory cards or discs, then carrying or sending the discs from 
one computer to another. This method of transferring files can be very time-consuming.  

 COST.  

Networkable versions of many popular software programs are available at considerable savings 
when compared to buying individually licensed copies.  

 SECURITY.  

Files and programs on a network can be designated as "copy inhibit," so that you do not have to 
worry about illegal copying of programs. Also, passwords can be established for specific 
directories to restrict access to authorized users.  

 CENTRALIZED SOFTWARE MANAGEMENT. 

 One of the greatest benefits of installing a network at a school is the fact that all of the software 
can be loaded on one computer (the file server). This eliminates that need to spend time and 
energy installing updates and tracking files on independent computers throughout the building.  

 RESOURCE SHARING.  

Sharing resources is another advantage of school networks. Most organizations cannot afford 
enough laser printers, fax machines, modems, scanners, and CD players for each computer. 
However, if these or similar peripherals are added to a network, they can be shared by many 
users.  

 ELECTRONIC MAIL.  

The presence of a network provides the hardware necessary to install an e-mail system. E-mail 
aids in personal and professional communication for all personnel, and it facilitates the 
dissemination of general information to the entire staff. Electronic mail on a LAN can enable 
students to communicate with teachers and peers at their own institute. If the LAN is connected 
to the Internet, we can communicate with others throughout the world.  

 FLEXIBLE ACCESS.  
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Networks allow users to access their files from computers throughout the institute. Like Students 
can begin an assignment in their classroom, save part of it on a public access area of the network, 
then go to the media center after school to finish their work. Students can also work 
cooperatively through the network.  

 WORKGROUP COMPUTING.  

Collaborative software allows many users to work on a document or project concurrently. For 
example, educators located at various schools within a county could simultaneously contribute 
their ideas about new curriculum standards to the same document, spreadsheets, or website.  

 

NETWORK TOPOLOGY 

Network topology refers to the layout used to wire the computers together.  

TYPES OF TOPOLOGY 

There are four main topologies that are used. 

1. BUS 
2. STAR 
3. RING  

BUS TOPOLOGY 

Each computer is connected to a single cable which connects all of the computers. All nodes (file 
server, workstations, and peripherals) are connected to the linear cable. 

 

 

 

 

 

 

Advantages of Bus Topology 
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 Easy to connect a computer or peripheral to a linear bus.  
 Requires less cable length than a star topology.  

Disadvantages of a Bus Topology 

 Entire network shuts down if there is a break in the main cable.  
 Terminators are required at both ends of the backbone cable.  
 Difficult to identify the problem if the entire network shuts down.  
 Not meant to be used as a stand-alone solution in a large building.  

STAR TOPOLOGY 

“All communication takes place via a central computer or HUB device.” 

A star topology is designed with each node connected directly to a central network hub, switch, 
or concentrator. 

Data on a star network passes through the hub, switch before continuing to its destination. The 
hub, switch, or concentrator manages and controls all functions of the network. It also acts as a 
repeater for the data flow.  

 

 

 

 

 

 

 

Advantages of a Star Topology 
 
• Easy to install and wire.  
• No disruptions to the network then connecting or removing devices.  
• Easy to detect faults and to remove parts.  
 
Disadvantages of a Star Topology 
 
• Requires more cable length than a linear topology.  
• If the hub or concentrator fails, nodes attached are disabled.  
• More expensive than bus topologies because of the cost of the HUB device. 
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RING TOPOLOGY 

Each computer is connected to the two computers on either side of it. The last computer is linked to the 
first to form a ring. 

  

 

 

 

 

 

 

 

 

Advantages of a Ring Topology 

• Easy to install and wire.  
• Equal Access to devices no one computer will use all the bandwidth 
• Easy to detect faults and to remove parts.  

 
Disadvantages of a Ring Topology 

 
• Slow since signals goes in sequential order 
• If the concentrator fails, nodes attached are disabled.  
• Single break in cable can disrupt the flow of network. 
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INTERNET 
 

DEFINATION: 

Internet is global “Network of Networks”. The internet is a worldwide public network of 
computers on which people can join and use multiple services such as sharing of information. 

By internet users at any one computer can get information from any other computer. 

 

 

 

 

 

 

HISTORY OF INTERNET 

It was developed by the United States Defense Advanced Research Projects Agency in the 1970s 
and was initially known as ARPANET.  

The Internet was designed to be used by companies and Universities doing military research so 
that they could share information. Since then the number of people who use the Internet and the 
services that are provided on the Internet have grown tremendously. There are now over 
200,000,000 people who regularly make use of it. 

 

CONNECTING METHODS TO THE INTERNET 

To connect to the Internet the following are needed: 

 a computer  

 telephone line  

 modem and/or router  

 an ISP (Internet Service Provider)  
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 Web browser, e.g. Internet Explorer, Firefox, Chrome, Safari, Opera etc. 
 

 

 

 

 

 

 

 

 

 

 

 

WHAT IS MODEM? 

A device which convert analog signals to digital signals and digital signals to analog for 
transmitting data over internet. 

 

WHAT IS WEB BROWSER? 

Web Browser is Software used to display the Web pages. Internet explorer is an example of web 
browser 

Here are some types of web browser: 

 Internet 
explorer 

 Firefox 

 Chrome 

 Safari 

 Opera 
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WHAT IS WEB SITE ADDRESS? 

Every web site has a specific address which is also called URL that is Uniform Resource 
Locator. 

EXAMPLE: 

http://www.paknews.com 

 

HTTP: Hyper Text Transfer Protocol, is rule to send and receive text on internet  
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WWW: World Wide Web, It consists of a large number of web servers that host websites. Each 
website will normally consist of a number of web pages. A web page can contain text, images, 
video, animation and sound. 

Paknews: Domain Name 

Com: type of web site there are many other types of web sites like  

 Pak: Pakistan 

  Edu: education 

 Mil: military 

 Gov: govt 

 Com: commercial 

 

 

ADVANTAGES OF INTERNET 

There many advantages to using the internet such as:  

 Email.  
 Sharing Information.  
 Services.  
 Buy or sell products.  
 Communities.  
 News 
 Searching jobs 
 Advertisement 
 Communication 
 Entertainment 
 Online education 
 Online education and research 

DISADVANTAGES OF INTERNET 

Although there are huge advantages of internet but there is always another side of picture. 

So internet has some disadvantages like 
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 Viruses 
 Security problem 
 Immorality  
 Many information is not accurate 
 Wastage of time 

EMAIL 

Electronic Mail (email) is a system which allows users of a computer network to send messages 
to each other. Users can usually: 

 Send a message to another user, or group of users.  
 Keep their messages in a mailbox.  
 Read, print and delete messages from their mailbox.  

It is not only typewritten messages that can be sent using Electronic Mail. Pictures, music, 
videos, in fact almost any sort of information you can think of, can also be sent. 

Each user has to have his or her own address that other users need to know to send messages to 
him or her.  

Electronic mail is good because it is much faster that the ordinary post. It is also very accessible 
since you can read your email on any suitable computer anywhere in the world. On the other 
hand not everybody has an electronic mailbox at the moment, so you cannot use email to send 
messages to everyone, and you certainly can’t send a parcel by email. 

There are many email service provider companies which allow any user to send and receive 
electronic mail like 

 Hotmail  
o www.hotmail.com 

 Yahoo 
o www.yahoo.com/mail 

 Gmail 
o www.gmail.com 
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WHAT IS SEARCH ENGINE 

 

“Internet search engines are special sites on the Web that are designed to help people find 
information stored on other sites.” 

Tool for finding information, especially on the Internet or World Wide Web. Search engines are 
essentially massive databases that cover wide swaths of the Internet. Search engines are the 
primary method Internet surfers use to locate information on the Web. 

We can search any information by use of search engines. There are thousands of different search 
engines to help people navigate the Internet. These include major commercial search engines—
like Yahoo!, Lycos, AltaVista, and Excit, as well as many smaller, industry-specific directories. 
There are even Meta searchers, which work by querying a number of other search engines and 
processing the results.  

Many of the major search engines are created through an automated process in which a program 
called a spider "crawls" across the Web to gather information about existing sites. The spider 
captures this basic information and organizes its findings into categorizes, which are then used to 
generate search results for users. Small businesses hoping to list an existing Web site with a 
major search engine may find that the process has already been completed for them by an 
automated spider 

 

Major search engines URLs are define below: 

Yahoo:  www.yahoo.com 

Google: www.google.com 

Alta vista: www.altavista.com 

Lycos: www.lycos.com 

Msn: www.msn.com 

 



Chapter No 12: Introduction to Windows 

149 
 

CHAPTER NO 12 

 

INTRODUCTION TO WINDOWS 

 

WHAT IS WINDOWS? 

DEFINATION:  

“Microsoft windows is an operating system for personal computers and users. It is developed by 
Microsoft Corporation. Many of computers are working with the windows operating system. 
Remaining computers use Linux or Macintosh operating systems.” 

Windows work with GUI (Graphical User Interface) in which we have a cursor and a screen to 
operate computer with the help of peripheral devices. 

HOW TO START A COMPUTER 
 

 On the front of the system unit you will find the start button which has a symbol like this 
on it: 

 
 
 
 
 
 
 
 
 
 
 
 
 

(Fig: Start Button) 
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 Press it firmly and then let go. 
 You will also need to turn on the monitor by pressing a button with a similar symbol on 

it: 
 The computer then starts the process of ‘booting up’ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 In order to start up successfully the computer first has to check that all it’s’ parts are 
working properly. You can hear the computer working away at this task, and see text on 
the screen which tells you what is happening. 

 The computer then has to load the Operating System the instructions that help it to run 
other programs. 

 Once this process is completed successfully you will see the Windows start up screen 
which tells you which version of the operating system is running e.g. Windows XP or 
Windows Vista.  

 
 Finally, you will see the Windows desktop screen & Taskbar and you will know that the 

computer is ready for use… 
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USING THE MOUSE AND CURSOR 

The mouse when you move the mouse on the table, you will see the cursor moving on screen. 
Put your hand on the mouse so you can move it around on the table and also click the buttons 
with your fingers. 
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FEATURES OF WINDOWS 
 

GRAPHICAL USER INTERFACE: 

Windows using graphical user interface environment that simplifies the user's interaction with 
the computer by representing programs, commands, files, and other options as visual elements, 
such as icons, pull-down menus, buttons, scroll bars, windows, and dialog boxes. 

START BUTTON 

On very left corner a Start button is located in windows. By clicking it we can access many of 
the main programs within the computer. It is very easy way to interact by computer programs 
just click on start button and access these programs like open a document, paint, calculator, 
manage files , maintain systems and many more. 

TASK BAR 

 

In the bottom section of the screen, there is (or there may be) a long bar. It is called the Taskbar:  

 

On the left side of the taskbar, there is an object labeled Start or . The 
appearance of this object depends on the type of Windows you are using but it plays the same 
role.  

On the right side of Start, there is a wide area that is empty when the computer starts. This is 
actually referred to as the taskbar.  

In some versions (Windows 95, 98, Windows Server 2003), the color of the taskbar may be gray 
(or Silver). In some other versions (Windows Millennium), the taskbar may be yellowish. In 
Windows XP, it may be blue.  

On the far right side of the taskbar is a section called the tray area. One of the things that this 
area displays is the current time (as set on your computer). 

 

ICONS 
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Icons are small graphical images that can represent your computer's programs, files, folders and 
printers amongst other things. 

To activate the program/file/folder that an icon represents you simply double click (two clicks in 
quick succession) on it with the left mouse button. This will activate the icon and either start a 
program or open a file/folder. 

The icons on your desktop can be renamed by right clicking on them and selecting rename. 
They can be deleted by right clicking and selecting delete. It's possible to create your own 
Windows desktop icons for programs, files, folders, etc.  

Examples of icons are 

 My computer  

 My document  

 Recycle bin   

 Shortcut  

  

 

MY COMPUTER: 

My computer icon has information displays all the components of the computer including disk 
drives and networks all parts of the computer can be accessed through My Computer's 
hierarchical structure double click on any icon to view the contents of a disk, folder or run a 
program. 

 

  

 

 

 

 

 

 

(Fig: my computer) 
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MY DOCUMENT: 

My Documents is the name of a special folder on the computer's hard disk that the system 
commonly uses can store his documents, music, pictures, downloads, and other files. 

 

 

 

 

 

 

 

(Fig: My Document) 

RECYCLE BIN: 

When you delete a file, Windows XP will place the file into the recycle bin (instead of deleting it 
altogether), this allows you to restore the file in case you deleted it by mistake.  
 
For example, if you deleted a file by accident you could double click on the recycle bin icon to 
see its contents. Inside you will see the file/folder that you deleted, to restore the file back to 
where you deleted it from, right click on it and then select restore from the menu that appears. 
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                               (Fig: Recycle bin) 

DESKTOP 

After you have started the computer, the area you are looking at is called the desktop. The 
desktop is usually different from one computer to another. This is because some items get added 
as new programs are installed on a computer, and other items get deleted at will. Eventually, you 
will know how to change the way your desktop looks. 

The Microsoft Windows desktop is made of various parts. From the upper left to the lower left 
side of the screen, there are small pictures or images called icons. Each one is used to make the 
computer do something. Here is an example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                          (Fig: Desktop) 
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HOW TO MANAGE AND CUSTOMIZE YOUR DESKTOP APPEARANCE 

Lots of computer users just leave their desktop with the default windows settings, but if you are a 
little bit creative and want your computer to be more "you", you have various options for 
customization.  

To get to where you make changes to the look & feel  

 Right-click on an empty area of your desktop  
 Click Properties 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From the drop-down menu under the "Themes" tab, you can choose a Theme. A theme will give 
you a background and a set of sounds, Icons and other elements that will change the Look & feel.  

You don't have to choose a Theme - you can also make your own settings.  
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From the Desktop tab in your properties window you can choose between many different pre-
installed patterns and pictures. Scroll through them and pick one, if you can find one you like. 
The images have different proportions, so you get another option on the right hand side of the 
window. You can choose to:  

 Center the image  
 Tile the image  
 or Stretch the image 

If you have a picture stored on your computer, you can choose to add you own picture to the list 
and use it as a wallpaper image.  

 Click the browse button on the right side of the window  
 In the drop-down menu on top of the window choose the location of your picture  
 Select the picture by clicking on it  
 Click open 
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THE SCREEN SAVER 
 
A screen saver is a moving design that appears on a computer screen when there has been no 
input for a specified period of time. Screen savers prevent the damage that occurs when the same 
areas of light and dark are displayed too long.  

It would actually take many hours to burn in an image on today's color monitors, but a lot of 
people find screen savers nice to look at and it "covers" up your work, if you have to leave the 
computer for a while.  

Pressing a key or moving the mouse restores the screen.  

To change the look of your screen saver choose the "Screen saver" tab in your desktop properties 
window. 
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From the drop-down menu choose one of the pre-installed screen savers. When you click on the 
screen savers in the menu, you will be able to preview, what it looks like. You can see a small 
sample desktop inside the window - or you can click the "preview" button to the right and see 
what it would look like on your monitor. To get out of the preview mode, simply click once 
anywhere on the screen.  

Another thing you are able to change is how your windows and buttons look, as well as the size 
of the font.  

 CLICK THE APPEARANCE TAB 

Depending on which Windows operating system you are using, you will find several choices in 
font-sizes and styles the drop-down menu. 
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START BUTTON AND START MENU: 

The Start Button starts programs, opens documents, and access most parts of the system. 
Windows Program menus can be customized as needed.  

 Program displays a list of the programs that are installed through Windows available 
to use. 

 Documents displays a list of the last 15 documents used allowing the user to open 
them directly from this menu  

 Settings displays system components, such as printers, control panel and taskbar  
 Find/Search has search abilities to find files, folders and phrases in documents on 

your computer  
 Help displays help topics broken up into contents, index and find components  
 Run allows you to start a program from a command line  
 Shut down shuts down the computer, restarts the computer or logs you off a network  
 Favorites and Active Desktop is an option available to Windows 98+ (or Internet 

Explorer 4x) users. 
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DETAILS 

 

 PROGRAMS 
 

The program contains a list of programs that are installed and store in your computer while 
you installed your operating system. All programs contain many sub options like: 

o Accessories: calculator, paint, word pad, Note pad and command prompt etc. 
o Internet explorer: a web browser to explore web site on internet. 
o Ms. Office: Very important application software contains, Ms. Word, Excel and 

Power point. 

 DOCUMENTS: 

This option contains the resent copies of files. It displays a list of the last 15 documents used 
allowing the user to open them directly from this menu and it is updated after some time 
whenever user modify or changed file.  

 

 CONTROL PANEL & SYSTEM PREFERENCES  

Control panel is used for setting hardware, programs, software and drivers of all components 
of system. It is used to change system settings like screen savers, time, screen colors.   

It is also used to add and remove programs, fonts add and make changes to hardware and 
software settings. 
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 USING HELP  

Help is to get help about a specific procedure click the help button in the top right corner of 
the screen  

o Contents list general topics grouped by subject  
o Index list specific topics accessed by scroll bars or typing the topic  
o Find creates an index of words in Help and allows searches by word or phrase  
o click Help Topics to return to the Help menu  
o Troubleshooters will step you through a series of steps to solve computer problems. 
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SEARCH  

To search for a file or folder:  

 Click Start, and then click Search.  

 In the Search Companion dialog box, click All files and folders.  

 Type part or all of the name of the file or folder, or type a word or phrase that is in the 

file.  

 In the Look in box, click the drive or drives, folder, or network location that you want to 

search.  

 Choose one of the following options:  

o Click When was it modified to look for files that were created or modified on or 

between specific dates.  

o Click What size is it to look for files that are specific size.  

o Click More advanced options to specify additional search criteria. 

 Click Search. 
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TURN OFF COMPUTER: 

 Close all programs that you have open, by clicking on the close button in the 
top right hand corner of the screen.  

 Don’t forget to close any programs that you have open, but minimized, on the task bar at 
the bottom of the screen: 

 

 
 
 

 One of the strange things about the PC is that you stop it from the Start Menu. 
 

 Using your mouse click on the Start button in the bottom left hand corner of the screen 
which opens the start menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on Turn Off Computer button 
 Click on the Turn off button. 
 This will complete the process of closing down the PC, but just as the computer takes 

time to boot up, so the shutting down process takes time as the computer shuts down all 
its’ operations safely. 
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CHAPTER NO 13 

 

 MANAGING FILES AND  

FOLDERS IN WINDOWS 

 

WHAT ARE FILES? 

Our computer network is like a huge filing cabinet that stores all our compute information. Each 
drive is like a separate drawer in the cabinet. A file is a single “document” that is saved to a 
drawer that means in diskette, USB, hard drive or any other storage device. 
 

Each letter, slide show, spreadsheet, or database you create is stored as a file. Every file saved 
has a filename. You can use multiple words for the filename; for example, Letter to Sam. Do 
NOT use special characters,   \ / : * ? " < > |   . 

Every file also has a three-letter extension, assigned by the Windows system that associates it 
with a specific program. For example, a WordPerfect complete file name would be "Letter to 
Sam.wpd" and a Word file name would be "Letter to Sam.doc". 

 

WHAT ARE FOLDERS? 

"Folders," also known as "directories," on your computer work in much the same way that file 
folders in the real world work. Folders are used to organize the data stored on your drives. The 
files that make up a program are stored together in their own set of folders.
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FILE STRUCTURE 
 
The file structure is best described and understood in a tree structure format. A tree structure is 
one way of representing any hierarchical structure in a graphical form.  
 
 
 
 
 
 
 
 
 
 
 
 
It is called a "tree structure" because the graph looks like an upside down tree meaning that the 
root of the tree is on the top and the leaves at the bottom. 
Microsoft Windows uses the same structure and we all use it everyday at work, even though it 
may not look like the figure above. Our shared drive data structure looks like the following: 
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ORGANIZING FILES AND FOLDERS 
 
As you can see in the previous example, the libraries shared drive is organized in a tree format. 
S:\ is the root and all other folders are contained inside it. Most departments have their own 
folders which is the root for their department. For example: UE examination department. 
 
Here is another way to think about it. Just imagine a filing cabinet with many drawers. Inside the 
drawers are many folders and within the folders there are other folders or individual documents. 
 
 
 
 
 
 
 
 
 
 
 
 
Notice the minus sign besides the shared folder. Whenever you see a minus sign beside a folder, 
it means the folder is fully expanded and does not contain anything else other than what is 
showing below it. A plus sign means that the folder contains at least one file or folder inside it. 
Clicking the plus sign will expand the folder and make known everything inside it. 
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HOW TO CREATE A FOLDER 

Here are the two most common ways of creating folders: 
 

1. In My Computer, double click on the folder where you would like to create a new folder. 
2. You can then create a new folder by selecting “Make a new folder” in the File and Folder 
3. Tasks drop-down menu. In the following example, a new folder will be created inside a 

previously created folder named “officework”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. A folder icon will appear. Please rename the folder with a descriptive name: 
 

 

 

 

OR 
 
 

5. You can also create a new folder by right clicking on an empty space in your H:\My 
Documents folder and selecting New and then Folder (this is all still in My Computer). 
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A folder icon will appear. Please rename the folder with a descriptive name: 
 

 

 

 

NAMING A FILE 
 
Definitions: 
File: A file is a single “document” that is saved to a diskette, USB, hard drive or any other 
storage device. 
Folder: A folder is where files are stored. 
Path: A path is the line of folders you must follow to locate a specific file; it begins with the 
drive letter designation and includes the folders. For example, H:\data\reports\status.doc is a 
path with file named status.doc that is on the H: drive and is in the reports subfolder of the data 
folder. 
All file systems follow the same general conventions: a base file name and an optional extension, 
separated by a period e.g. abc.doc. 

 
MAXIMUM LENGTH 
 
In Windows, the maximum length for a path is 255 characters including spaces, hyphens, 
underscore and any other character you use (no periods allowed). A path is structured in the 
following order: drive letter, colon, backslash, components separated by backslashes, for 
 
Example:  
H:\my documents\personal\trips-I-have-taken-in-the-past-few-years\I-have-onlytaken- 
one-trip\i_need_to_go_travel_some-more\my-pictures\year- 2006\May\first_week\hiking-in-the-
mountains\this-is-the-maximum-length-of-a-filename\ including-the-folders\LK.html. 
 
Note: As you may have noticed above the actual file name is only two characters (not including 
the .html extension) but remember the maximum length for a file path is 255 characters, so 
depending on how many folders you have inside a folder where you are storing the file, the 
length of the actual file name will be restricted. 

 
 
 
NAMING CONVENTIONS 
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Do not assume case sensitivity. Consider names such as OFFICE, office, and office to be the 
same. 
Use a consistent method for file and folder naming. 
Avoid too many folders inside a folder (remember the path length limit). 
 

BROWSING FILES 

 
Even when you know where a file is stored, sometimes there are so many files in the folder that 
it is difficult to find the file you want. The best way to search through a large folder is to use the 
“Details” view. The “Details” view allows you to quickly sort your files and view different types 
of information about all the files in a folder. 
 
To use the Details view 
 

1. Open the folder you want to browse. In the example, I am in my “Pictures” folder. 
2. Click the “Views” button, and then click “Details”. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Sometimes it is easier to find a file if all the files are sorted in a particular way. Suppose 
you created a file yesterday afternoon but do not remember what you named it.  
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4. Click the column heading that you want to sort by. For example, to sort files from oldest 
to newest, click the “Date Modified” heading. To reverse the sort order (for example, to 
sort from newest to oldest), click the column heading twice. 

 

 

 

 

 

 

 

 

 

5. By default, the “Details” view shows the file name, date, size, and type. You can add 
other information as well. To add or remove columns, right-click a column heading, and 
then click “More”. 
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6. In the Choose Details dialog box, select the columns you want to see in the Details view. 
For pictures and videos, you can add Dimensions to sort by size. For music, you can add 
Artist, Album Title, and Genre to make it easier to find the songs you want. 

 

 

 

 

 

 

 

 

 

 

 

7. Click “OK” to add the columns to your Details view. 
 

8. When you modify the columns in the Details view, it affects only the folder you are 
viewing. 
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MOVING FILES FROM ONE FOLDER TO ANOTHER 
 
Sometimes you need to move files that you have already created into another location. It has two 
methods for exploring any document defined below: 
 
METHOD 1 
 

1.  Click “Start”          “Programs”        “Accessories”        “Windows Explorer”. 
 
 
 
 

 
 
 
 

2. In “Window Explorer”, locate and select the file or folder you need to move using the 
tips above. 

3. 3. Expand to the destination folder by clicking on the “+” sign if needed 
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4. Drag the file or folder to the destination and drop it in. 

 
 
 
 
 
 
 
 

 

 

 

METHOD 2 
 

1. In “My Computer”, locate and select the file or folder you need to move using the tips 
above. 

2. Click “Edit”      “Cut” or press Ctrl + x on the keyboard to cut the file. 
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3. Open the destination folder. 
 

4. Click “Edit”            “Paste” or press Ctrl + v on the keyboard to paste the file. 
 

 

 

 

 

 

 

 

 

 

 

OPENING FILES 
 
Sometimes you open up Microsoft Word and click “File”       “Open” and pick the file you want 
to open and you get the following error message: 
 

 

 

 

 

 

 

 

This happens because you are trying to open a file in Microsoft Word that is not a “Word” file 
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(.doc) but rather in some other format such as power point (.jpg, .ppt, .pdf ), etc. 
Another way to open a file is by navigating to the file in “My Computer” and then double 
clicking on the file. The file will automatically open in the appropriate program whether it is 
Microsoft Word or PowerPoint. 
 

HOW TO CREATE SHORTCUTS? 
 
Shortcuts can make your life easier or harder depending on how you use them. By creating too 
many shortcuts you will clutter up your desktop. A shortcut is just a reference link on your 
desktop to a file or a program.  
 
Example: 
You could create a shortcut on your desktop of a file saved on your H:\ drive that you access 
everyday or quite frequently. This way your file stays on the H:\ drive but you create a link to the 
file by creating a shortcut. This allows you easy access to the file without compromising the file 
in case of hard drive failure. 
 
Note: Copying or saving a file to your desktop is not the same thing as creating a shortcut. When 
you copy a file to the desktop, you actually make a duplicate copy of the original. This means 
you have two files now, one on the desktop and another in the original location. Making any 
changes to one of the files will not change the other. 

 
CREATING SHORTCUTS: 
 
Here is one way to create shortcuts: 
 

1. Click on Start      Programs      Accessories      Windows Explorer. 
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2. Find the file or program you want to create a shortcut for. 
 

3. Right click on the file, then click on “Send to” and then click “Desktop (create shortcut)” 
4. You should now see a shortcut icon on your desktop. 
 
 

 
 

NOTE: A black arrow on the icon means that it is a shortcut. Otherwise, it 
may be a copy of the file.  
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CHAPTER NO 14 

 

 MICROSOFT WORD 2007 

 

WHAT IS WORD PROCESSOR? 

A word processing package is used to prepare and edit text. Word processors are used to 
create all types of documents such as letters, reports and essays. Using a word processor you can 
type, revise and correct a document on the screen before printing it out. The layout of the page 
can be changed and a wide variety of different styles of text can be used to improve the 
presentation of a document. Tools such as spelling checkers can help ensure that the contents of 
a document are accurate. 

The functions of a word processor can be divided up into several different categories: 

 Page Layout: The page layout functions let you decide how each page will be set out.  
 Text Presentation: The appearance of text can be easily altered. Different fonts and 

styles can be used and the size of text can be varied. Text can be neatly lined up on the 
page.  

 Editing of Text: Text editing functions are used to revise and change text that you have 
entered.  

 Blocks of Text: The style and position of selected blocks of text can be changed.  
 Text Analysis: The word processor can look at your document and try to highlight any 

errors such as spelling or grammatical mistakes that you have made.  
 Templates: Template files let you save favorite document layouts that you have created 

so that you can use them over and over again.  
 Other Features: Most modern word processors will offer lots of extra features such as 

tables, bullet points and fancy text effects.  
 Mail Merging: A database of names and addresses can be used to personalize letters that 

have been created in a word processor.  
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GETTING STARTED  
 

SCREEN LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
To get started first familiarize you with the layout of Microsoft Word 2007. If you will analyze 
the layout then you will notice it does not have the regular menu system. It now has tabs and 
buttons. 
 

1. OFFICE BUTTON 
2. QUICK ACCESS TOOLBAR 
3. TABS 
4. RIBBON. 
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1) OFFICE BUTTON 
 

The Microsoft Office button performs many of the functions that were located in the File 
menu of older versions of Word. This button allows you to create a new document, open an 
existing document, save or save as, print, send (through email or fax), publish or close.  

 

This is also where you can customize your Quick Access Toolbar. 
 

 Start new project; Open a Project, Save, Print, etc. 
 This shows recent documents and is a quick way to open a recent project. 
 This opens the Word Options window where you can change settings and customize your 

Quick Access Toolbar. 
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2) QUICK ACCESS TOOLBAR: 
 

The quick access toolbar is a customizable toolbar that contains commands that you may 
want to use. You can place the quick access toolbar above or below the ribbon. To change 
the location of the quick access toolbar, click on the arrow at the end of the toolbar and click 
on Show below the Ribbon.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

With this tool bar one can set it up to fit his/her needs. To do so just click the arrow at the 
end of this bar and select which items best suit your needs. it will be placed in the order that 
are selected.  
Again to customize this Quick Access Toolbar  

 Go to the office button and select Word Options. 
 Click customizes on the left and you can search for any buttons that suit your needs. 
 A Shortcut to customize this bar is to right click in the Tabs bar and select Customize 

Quick Access Toolbar. 
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3) TAB 
 

Tabs are similar to the menu system of MW2003 (Microsoft Word 2003) instead of having 
dropdown menus MW2007 (Microsoft Word 2007)  created the Tab and Ribbon system. 
When you select a tab it will display the Ribbon associated with that tab. Here everything has 
been changed into button form. 

 

4) RIBBON  

The Ribbon is the panel at the top portion of the document. It has mainly seven tabs: Home, 
Insert, Page Layout, References, Mailings, Review, and View that contain many new and 
existing features of Word. Each tab is divided into groups.  
The groups are logical collections of features designed to perform functions that you will 
utilize in developing or editing your Word document. Commonly used features are displayed 
on the Ribbon, to view additional features within each group, click on the arrow at the 
bottom right of each group.  

 

HOME Clipboard, Fonts, Paragraph, Styles, and Editing. 
INSERT Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols. 
PAGE LAYOUT Themes, Page Setup, Page Background, Paragraph, Arrange  
REFERENCES Table of Contents, Footnote, Citation & Bibliography, Captions, Index, 

and Table of Authorities  
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MAILING Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish 
REVIEW Proofing, Comments, Tracking, Changes, Compare, Protect  
VIEW Document Views, Show/Hide, Zoom, Window, Macros  

 

 
WORKING WITH DOCUMENTS 

 
 
CREATE A NEW DOCUMENT  
 
There are several ways to create new documents, open existing documents, and save documents 
in Word:  

 Click the Microsoft Office Button       and Click New 
 
Or  
 

 Press CTRL+N (Depress the CTRL key while pressing the “N”) from the keyboard  
 
You will notice that when you click on the Microsoft Office Button and Click New, you have 
many choices about the types of documents you can create. If you wish to start from a blank 
document, click Blank. If you wish to start from a template, you can browse through your 
choices on the left, see the choices on center screen, and preview the selection on the right 
screen.  
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OPENING AN EXISTING DOCUMENT  
  

 Click the Microsoft Office Button  and Click Open, 
 

OR 
 

 Press CTRL+O (Depress the CTRL key while pressing the “O”) from the keyboard,  
 

OR 
  

 If you have recently used the document you can click the Microsoft Office Button  
and click the name of the document in the Recent Documents section of the window 
Insert picture of recent docs  

 
SAVING A DOCUMENT  
 

 Click the Microsoft Office Button  and Click Save or Save As 
 
Note: 
if you’re sending the document to someone who does not have Office 2007, you will 
need to click the Office Button, click Save As, and Click Word 97-2003 Document),  
 
                                                                OR 
 

 Press CTRL+S (Depress the CTRL key while pressing the “S”) from the keyboard,  
 
                                                                OR                     

  
 Click the File icon on the Quick Access Toolbar  
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RENAMING DOCUMENTS  
 
 
To rename a Word document while using the program:  
 

 Click the Office Button  and find the file you want to rename.  
 Right-click the document name with the mouse and select Rename from the shortcut 

menu.  
 Type the new name for the file and press the ENTER key.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

WORKING ON MULTIPLE DOCUMENTS  
 
Several documents can be opened simultaneously if you are typing or editing multiple 
documents at once. All open documents will be listed in the View Tab of the Ribbon when you 
click on Switch Windows. The current document has a checkmark beside the file name. Select 
another open document to view it.  
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DOCUMENT VIEWS 
 
 
 There are many ways to view a document in Word.  
 

 Print Layout: This is a view of the document, as it would appear when printed. It 
includes all tables, text, graphics, and images.  

 Full Screen Reading: This is a full view length view of a document. Good for viewing 
two pages at a time.  

 Web Layout: This is a view of the document, as it would appear in a web browser. 
 Outline: This is an outline form of the document in the form of bullets.  
 Draft: This view does not display pictures or layouts, just text.  

 
To view a document in different forms, click the document views shortcuts at the bottom of the 
screen  
 

 

OR 

 

 

 

 

CLOSE A DOCUMENT  
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 To close a document:  
 Click Close  

 

EDITING WITH DOCUMENT 

 
TYPING AND INSERTING TEXT 
 

 To enter text just starts typing! The text will appear where the blinking cursor is located. Move 
the cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the 
left button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The keyboard shortcuts listed below are also helpful when moving through the text of a 
document:  
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MOVE ACTION KEYSTROKE 

Beginning of the line  HOME 

End of the line  END 

Top of the document  CTRL+HOME 

End of the document  CTRL+END 

 
 

SELECTING TEXT  
 
 
 
 

To change any attributes of text it must be highlighted first. Select the text by dragging the 
mouse over the desired text while keeping the left mouse button depressed, or hold down the 
SHIFT key on the keyboard while using the arrow buttons to highlight the text.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The following table contains shortcuts for selecting a portion of the text:  
 
 

SELECTION  TECHNIQUE 

Whole word  double-click within the word  
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Whole paragraph  triple-click within the paragraph  

Several words or 
lines  

drag the mouse over the words, or hold down SHIFT while using the 
arrow keys  

Entire document  choose Editing | Select | Select All from the Ribbon, or press CTRL+A  

 
Deselect the text by clicking anywhere outside of the selection on the page or press an arrow key 
on the keyboard.  
 

INSERTING ADDITIONAL TEXT: 
 
 
 
 
 Text can be inserted in a document at any point using any of the following methods:  
 

I. Type Text: Put your cursor where you want to add the text and begin typing  
 

II. Copy and Paste Text: Highlight the text you wish to copy and right click and click Copy, put 
your cursor where you want the text in the document and right click and click Paste.  

 
III. Cut and Paste Text: Highlight the text you wish to copy, right click, and click Cut, put your 

cursor where you want the text in the document, right click, and click Paste.  
 
IV.  Drag Text: Highlight the text you wish to move, click on it and drag it to the place where you 

want the text in the document.  
 
 
 
 
 
 

 TYPE TEXT:  
 
Put your cursor where you want to add the text and begin typing. (Describe above) 

 

 COPY & PASTE TEXT: 

 Select text which you want to copy by using mouse or key board (by shift and arrow 
keys) 

 
 

o Press CTRL+C (Depress the CTRL key while pressing the “C”) from the 
keyboard,  
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OR 

 
o You can select a shortcut button on ribbon a copy. 
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 Where you want to paste, you have to take cursor by using key board arrow keys Or by 
mouse click. 
 

o Press CTRL+V (Depress the CTRL key while pressing the “V”) from the 
keyboard, for paste the text. Which you already copy. 

 
OR 

 
o You can select a shortcut button on ribbon as “Paste”. 

 
 

 

 

 

 

 

 

 CUT AND PASTE TEXT: 

 Select text which you want to cut by using mouse or key board (by shift and arrow keys) 
 

 
 Press CTRL+X (Depress the CTRL key while pressing the “X”) from the keyboard,  

 
OR 

 
 You can select a shortcut button on ribbon a cut. 

 

 Where you want to paste, you have to take cursor by using key board arrow keys Or by 
mouse click. 

 
 Press CTRL+V (Depress the CTRL key while pressing the “V”) from the keyboard, 

for paste the text. Which you already copy. 
 

OR 
 
 You can select a shortcut button on ribbon as “Paste”. 

Cut 

Paste 

Copy 
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NOTE: 

Text which is selected for paste is saved in Clipboard. Until you never paste it at desire location. 

 DRAG TEXT: 

Highlight/select the text you wish to move, click on it and drag it to the place where you want the text in 
the document. 

 

SEARCH/FIND AND REPLACE TEXT  
 

To find a particular word or phrase in a document:  
 

 Click Find on the Editing Group on the Ribbon  
 

OR 
 

 Press CTRL+F (Depress the CTRL key while pressing the “F”) from the keyboard. 
 
 

A dialog box will appear and to find any word write it in “find what” text box. 
 
To replace a particular word or phrase in a document:  

 
 Click Replace on the Editing Group on the Ribbon  
 

OR 
 

 Press CTRL+H (Depress the CTRL key while pressing the “H”) from the keyboard. 
 

 
In Find/Replace dialog box write word which you want to replace instead of the previous one 
and click replace or replace all according to requirement. Difference between replace and replace 
all is, to replace a single selected text or replace all where ever that particular text exists. 
Both options are also available in Ribbon: 
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UNDO CHANGES 
 

To undo changes:  
 

 Click the Undo Button on the Quick Access Toolbar  
 

OR 
 

 Press CTRL+Z (Depress the CTRL key while pressing the “Z”) on the keyboard. 
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FORMATING WITH TEXT 

 
STYLES 
 
 A style is a format-enhancing tool that includes font typefaces, font size, effects (bold, italics, 
underline, etc.), colors and more. You will notice that on the Home Tab of the Ribbon, that you 
have several areas that will control the style of your document: Font, Paragraph, and Styles.  

 

 
 

WHAT IS FONT? 
 

A font is a style of writing. Modern word processors are supplied with a wide range of fonts for 
you to choose from. Different fonts are useful for different purposes.  

Plain fonts such as Arial and Times New Roman are good for writing letters and reports. Fancier 
fonts such as Keystroke and Lincoln are suitable for use on posters. 

 
 
 

CHANGE FONT TYPEFACE AND SIZE 
  

To change the font typeface:  
 

 Click the arrow next to the font name and choose a font.  
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You can preview how the new font will look by highlighting the text, and hovering over the new 
font typeface.  
 

 

 

 

 

 

 

 

 

 

 

To change the font size:  
 

 Click the arrow next to the font size and choose the appropriate size, or  
  Click the increase or decrease font size buttons.  

 

 

 

 

 

 

 

FONT EFFECTS  

Font styles are predefined formatting options that are used to emphasize text. They include: 
Bold, Italic, and Underline. To add these to text:  
 

 Select the text and click the Font Styles included on the Font Group of the Ribbon, or  
 Select the text and right click to display the font tools  
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For Bold: 

 Select text which you want to bold  
 

o Click the Bold Button included on the Font Group of the Ribbon. 
 

OR 
 

o Press CTRL+B (Depress the CTRL key while pressing the “B”) from the 
keyboard. 

 
 

 

 

 

 

For Italic: 

 Select text which you want to view as italic  
 

o Click the Italic Button included on the Font Group of the Ribbon. 

Underline 

Bold 

Italic 
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OR 

 
o Press CTRL+I (Depress the CTRL key while pressing the “B”) from the 

keyboard. 
 

For Underline: 

 Select text which you want to underline  
 

o Click the Underline Button included on the Font Group of the Ribbon. 
 

OR 
 

o Press CTRL+U (Depress the CTRL key while pressing the “U”) from the 
keyboard. 

 

CHANGE TEXT COLOR 
 
 To change the text color:  

 Select the text and click the Colors button included on the Font Group of the Ribbon, or  
 Highlight the text, right click, and choose the colors tool.  
 Select the color by clicking the down arrow next to the font color button.  

 
 

 

 

HIGHLIGHT TEXT 
 

Highlighting text allows you to use emphasize text as you would if you had a marker. To 
highlight text:  

 Select the text  
 Click the Highlight Button on the Font Group of the Ribbon, or  
 Select the text and right click and select the highlight tool  
 To change the color of the highlighter click on down arrow next to the highlight button.  
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COPY FORMATTING  

 
If you have already formatted text the way you want it and would like another portion of the 
document to have the same formatting, you can copy the formatting. To copy the formatting, do 
the following:  

 Select the text with the formatting you want to copy.  
 Copy the format of the text selected by clicking the Format Painter button on the 

Clipboard Group of the Home Tab  
 Apply the copied format by selecting the text and clicking on it.  

 
 
 
 

 

 

 

 
CLEAR FORMATTING  
 
To clear text formatting:  
 

 Select the text you wish to clear the formatting  
 Click the Styles dialogue box on the Styles Group on the Home Tab  
 Click Clear All 
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Now the categories in each Ribbon may have a button at the end of its bar. If you click this 
button it will expand into a window and show more options. For example the Font category will 
expand into a window where it will have all the settings for the font and character spacing. 

 

 

WHAT IS WORDART? 
 
WordArt allows you to use special effects such as bending, twisting and rotating text in your 
documents. Any text can be formatted and there is a gallery from which styles can be  selected. 
Some examples of WordArt are as follows; 
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INSERTING WORDART 
 

 From the insert tab, select WordArt from the text options available. This can be found on 
the right hand side of the toolbar. 

 From the WordArt gallery, select a WordArt style. 
 Click here to open the WordArt gallery 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 From the WordArt gallery, select a WordArt style. 
 Type your text in the space provided and if you would like to, choose a new Type face, 

size or style. 
 
Tip: Large, bold, sans serif typefaces such as Arial, Arial Black or Helvetica make good 
choices for WordArt 
 
 Click ok. Your WordArt will be inserted onto the page and the WordArt toolbar will 

appear at the top of the window. 
 To close WordArt, move the pointer away from your inserted WordArt and click once. 

 
 
EDITING WORDART WITH THE WORDART TOOLBAR 
 

• Double click on your inserted WordArt to make the toolbar reappear. 
• The toolbar will appear as follows. 
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BULLET AND NUMBERING 

Bulleted lists have bullet points, numbered lists have numbers, and outline lists combine 
numbers and letters depending on the organization of the list.  
To add a list to existing text:  
 

 Select the text you wish to make a list  
 From the Paragraph Group on the Home Tab, Click the Bulleted or Numbered Lists 

button  
 
 
 
 
 
 
 
 
 
 
 
To create a new list:  
 

  Place your cursor where you want the list in the document  
 Click the Bulleted or Numbered Lists button  
   Begin typing  

 
NESTED LISTS 
 
 A nested list is list with several levels of indented text. (mean list within the list) To create a 
nested list:  

 Create your list following the directions above  
 Click the Increase or Decrease Indent button  
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FORMATTING LISTS 
 
 The bullet image and numbering format can be changed by using the Bullets or Numbering 
dialog box.  

 Select the entire list to change all the bullets or numbers, or Place the cursor on one line 
within the list to change a single bullet  

 Right click  
 Click the arrow next to the bulleted or numbered list and choose a bullet or numbering 

style.  
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FORMATING WITH PARAGRAPH 

 

Formatting paragraphs allows you to change the look of the overall document. You can access 
many of the tools of paragraph formatting by clicking the Page Layout Tab of the Ribbon or the 
Paragraph Group on the Home Tab of the Ribbon.  
 

 

 

CHANGE PARAGRAPH ALIGNMENT  
 
 

The paragraph alignment allows you to set how you want text to appear. To change the 
alignment:  
 

 
 Click the Home Tab  
 Choose the appropriate button for alignment on the Paragraph Group.  

o Align Left: the text is aligned with your left margin  
o Center: The text is centered within your margins  
o Align Right: Aligns text with the right margin  
o Justify: Aligns text to both the left and right margins.  
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ADD BORDERS AND SHADING  
 
You can add borders and shading to paragraphs and entire pages. To create a border around a 
paragraph or paragraphs:  

 Select the area of text where you want the border or shading.  
 Click the Borders Button on the Paragraph Group on the Home Tab  
 Choose the Border and Shading  
 Choose the appropriate options  
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ADDING TABLE 

 
CREATE A TABLE 
 
 To create a table:  

 Place the cursor on the page where you want the new table  
 Click the Insert Tab of the Ribbon  
 Click the Tables Button on the Tables Group. You can create a table one of four ways:  

o Highlight the number of row and columns  
o Click Insert Table and enter the number of rows and columns  
o Click the Draw Table, create your table by clicking and entering the rows and 

columns  
o Click Quick Tables and choose a table  

 
 
 

 

 

 

 

 

 
 
 

ENTER DATA IN A TABLE 
 
 Place the cursor in the cell where you wish to enter the information. Begin typing.  
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DRAW TABLE 
 
You can draw a complex table — for example, one that contains cells of different heights or a 
varying number of columns per row.  As below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For that purpose we need draw table option from table in insert tab. Process of draw table is as: 

 

 

 

 

 

 

 

 

 Click where you want to create the table 

 On the Insert tab, in the Tables group, click Table, and then click Draw Table. 

 The pointer changes to a pencil 

DRAW TABLE 
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 To define the outer table boundaries, draw a rectangle. Then draw the column lines and 
row lines inside the rectangle. 

 To erase a line or block of lines, under Table Tools, on the Design tab, in the Draw 
Borders group, click Eraser. 

 Click the line that you want to erase. To erase the entire table, see Delete a table or clear 
its contents. 

 When you finish drawing the table, click in a cell and start typing or insert a graphic. 

 

MODIFY THE TABLE STRUCTURE AND FORMAT A TABLE 

 
 To modify the structure of a table:  

 Click the table and notice that you have two new tabs on the Ribbon: Design and 
Layout. These pertain to the table design and layout.  

 

 

 

On the Design Tab, you can choose:  
 

  Table Style Options  
 Table Styles  
 Draw Borders  

 
To format a table, click the table and then click the Layout Tab on the Ribbon. This Layout tab 
allows you to: 
 

 View Gridlines and Properties (from the Table Group)  
 Insert Rows and Columns (from the Rows & Columns Group)  
  Delete the Table, Rows and/or Columns (from the Rows & Columns Group)  
 Merge or Split Cells (from the Merge Group)  
 Increase and Decrease cell size (Cell Size Group)  
 Align text within the cells and change text directions (Alignment Group)  
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GRAPHICS 

Word 2007 allows you to insert many graphical objects as  
 

 Special Characters & Symbols 
 Equations  
 Pictures 
 Watermarks.  

 

 

 

SYMBOLS SPECIAL CHARACTERS: 

Special characters are punctuation, spacing, or typographical characters that are not generally 
available on the standard keyboard. To insert symbols and special characters:  
 

 Place your cursor in the document where you want the symbol  
 Click the Insert Tab on the Ribbon  
 Click the Symbol button on the Symbols Group  
 Choose the appropriate symbol.  
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EQUATIONS  
 
Word 2007 also allows you to insert mathematical equations. To access the mathematical 
equations tool:  
 

 Place your cursor in the document where you want the symbol  
 Click the Insert Tab on the Ribbon  
 Click the Equation Button on the Symbols Group  
  Choose the appropriate equation and structure. 
 You can make new equation as well by insert equation. 

 
 

 

 

 

 

 

 

 

 

 

PICTURES/CLIP ART  

 

Word 2007 allows you to insert Clip Art/ Pictures into a document. To insert :  
 

 Place your cursor in the document where you want the picture  
 Click the Insert Tab on the Ribbon  
 Click the Clip Art Button  
 The dialog box will open on the screen and you can search for clip art.  
 Choose the picture you wish to include  
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To insert any picture: 
 

  Place your cursor in the document where you want the picture  
  Click the Insert Tab on the Ribbon  
 Click the Picture Button  
  Browse to the picture you wish to include  
  Click the Picture  
  Click Insert  
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RESIZE GRAPHICS  
 
All graphics can be resized by clicking the image and clicking one corner of the image and 
dragging the cursor to the size you want the picture.  
 

 

 

 

 

 
 
 
FORMAT PICTURES  
 

 Picture can be resized by clicking the image and right clicks that image and select format 
picture.  

 It has many other options like color 3-D format, Line color and fill. 

 You can select any combination up to your requirment. 
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APPLY WRAPPING STYLES TO A GRAPHIC 
 

Once you have inserted a picture into your document, you can control the way text will wrap around it 

 Click your graphic to select it.  
 On the Format menu, click Picture.  
 In the Format Picture dialog box, click the Layout tab.  
 Click a wrapping style, and then click OK.  

 
 

 
 

 
 

By these options we can manage many you can arrange the layout of text and picture 
wrapping. There are many options in wrapping layout like  

 Square 

 The line with text 

 Tight 

 Behind text 

 In line with text 
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WATERMARKS  
 
A watermark is a translucent image that appears behind the primary text in a document. To insert 
a watermark:  

 Click the Page Layout Tab in the Ribbon  
 Click the Watermark Button in the Page Background Group  
 Click the Watermark you want for the document or click Custom Watermark and 

create your own watermark  
 To remove a watermark, follow the steps above, but click Remove Watermark  
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PROOFING A DOCUMENT 
 
 
There are many features to help you proofread your document. These include: Spelling and 
Grammar and Thesaurus.  
 
 
SPELLING AND GRAMMAR 
 
To check the spelling and grammar of a document  
 

 Place the cursor at the beginning of the document or the beginning of the section that you 
want to check  

 Click the Review Tab on the Ribbon  
 Click Spelling & Grammar on the Proofing Group.  

 

 
 Any errors will display a dialog box that allows you to choose a more appropriate 

spelling or phrasing.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 If you wish to check the spelling of an individual word, you can right click any word that 
has been underlined by Word and choose a substitution.  
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THESAURUS 
 
 The Thesaurus allows you to view synonyms. To use the thesaurus:  

 Click the Review Tab of the Ribbon  
 Click the Thesaurus Button on the Proofing Group.  
 The thesaurus tool will appear on the right side of the screen and you can view word 

options.  
 

 
 

 

 

 

 

 

 

 

 You can also access the thesaurus by right-clicking any word and choosing Synonyms on 
the menu.  
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PAGE FORMATING 
 

ORIENTATION 

You can print onto a piece of paper in one of two orientations, which are usually known as 
portrait and landscape. These two orientations look like this: 

 

Sometimes portrait is known as tall and landscape is known as wide. 

MARGINS 

It is usual to leave a small gap between the writing on a page and the edge of the page. This gap 
is called a margin. Leaving a margin is especially important when you need to bind a document 
together. Even if you do not want to leave a margin you will probably have to. Most printers 
cannot print right to the edge of the page.  

 

You can normally set the size of the top, bottom, left and right margins separately by typing in 
the distance from the edge of the page to the text. 



Chapter No 14: Microsoft Word2007 

219 
 

 

MODIFY PAGE MARGINS AND ORIENTATIONS 
 
The page margins can be modified through the following steps:  
 

 Click the Page Layout Tab on the Ribbon  
 On the Page Setup Group, Click Margins  
 Click a Default Margin, or  
 Click Custom Margins and complete the dialog box.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

APPLY A PAGE BORDER AND COLOR  
 
To apply a page border or color:  
 

 Click the Page Layout Tab on the Ribbon  
 On the Page Background Group, click the Page Colors or Page Borders drop down 

menus  
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HEADERS AND FOOTERS 

When writing a document containing many pages such as a report you may want the same 
information to appear at the top and bottom of each page.  

For example you may want the name of the document and your name to appear at the top of each 
page. You may want to print each page's number at the bottom of the pages. 

 Header: Text appearing at the top of each page is known as a header.  
 Footer: Text appearing at the bottom of each page is known as footer.  

 

Many word processors will let you type special codes which will automatically insert 
Information such as the current date or current page number into the header or footer of a 
document. 

INSERT COMMON HEADER AND FOOTER INFORMATION  
 
To insert Header and Footer information such as page numbers, date, or title, first, decide if you 
want the information in the header (at the top of the page) or in the Footer (at the bottom of the 
page), then:  
 

 Click the Insert Tab on the Ribbon  
 Click Header or Footer  
 Choose a style  
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 The Header/Footer Design Tab will display on the Ribbon  
 Choose the information that you would like to have in the header or footer (date, time, 

page numbers, etc.) or type in the information you would like to have in the header or 
footer  

 

 

MAIL MERGING 

Mail merging is a technique used mainly by companies and clubs to send personalized letters to 
customers or members. Using a standard (or form) letter and a database of names and addresses 
personalized letters addressed to the people in the database can be easily produced. The names 
and addresses of the people are automatically put onto the letters: 

 

There are four main steps that must be followed to create mail merged letters. They are : 

 Create The Database: If the database containing the names and addresses of the people 
to send the letter to does not already exist then it must be created.  

 Write The Letter: The letter to send should be created in the word processor. Special 
codes must be placed in the letter where the names and addresses of the customers should 
appear.  
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 Link The Letter And Database : The database and letter must now be linked together so 
that the mail merge function knows which file contains the names and addresses to fill 
into the letters  

 Perform The Mail Merge: When the mail merge is performed one letter will be 
produced for each person in the database. The names and addresses will be filled in on 
each letter.  
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CHAPTER NO 15 

 

 MICROSOFT POWER POINT 2007 

 

WHAT IS POWER POINT PRESENTATION? 

PowerPoint is a presentation software program that is part of the Microsoft Office package.  

PowerPoint uses a graphical approach to presentations in the form of slide shows that accompany 
the oral delivery of the topic. This program is widely used in business and classrooms and is an 
effective tool when used for training purposes. 

PowerPoint is one of the simplest computer programs to learn. It is the easy and good program 
used worldwide for presentations. Anyone can create stunning presentations that look like they 
were designed by a professional.  

It is easy to customize presentations with your company logo and to dazzle your audience by 
using one of the many design templates that come with the programs. Many more free templates 
are available online from Microsoft and a host of other websites.  

In addition to an on screen slide show, PowerPoint has printing options that allow the presenter 
to provide handouts and outlines for the audience as well as notes pages for the speaker to refer 
to during the presentation.  

WHAT IS PRESENTATION? 

A presentation is a collection of data and information that is to be delivered to a specific 
audience.  A PowerPoint presentation is a collection of electronic slides that can have text, 
pictures, graphics, tables, sound and video.  This collection can run automatically or can be 
controlled by a presenter. 



Chapter No 15: Microsoft power point 2007 

221 
 

 

GETTING START 

To start MS Power Point click on the Start Menu on the bottom left corner of your 
desktop and select Start→ All Programs→ Microsoft Office →Microsoft Office 
Power Point 2007.  

 

SCREEN LAYOUT 
 

Getting started with PowerPoint 2007 will notice that there are many features that you’ll be able 
to utilize for presentation.  There are three features that you should remember as you work within 
PowerPoint 2007:  

1. The Microsoft Office Button,  
2. The Quick Access Toolbar,  
3. The Ribbon.   

The function of these features will be more fully explored below. 
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MICROSOFT OFFICE BUTTON 

The Microsoft Office Button performs many of the functions that were located in the File menu 
of older versions of PowerPoint.  This button allows you to create a new presentation, Open an 
existing presentation, save and save as, print, send, or close. 

 

 

 

 

 

RIBBON 

The ribbon is the panel at the top portion of the document   it has seven tabs:  Home, Insert, 
Design, Animations, Slide Show, Review and View.  Each tab is divided into groups.  The 
groups are logical collections of features designed to perform function that you will utilize in 
developing or editing your PowerPoint slides.   

 

Commonly used features are displayed on the Ribbon, to view additional features within each 
group, click on the arrow at the bottom right of each group.  
 

HOME: Clipboard, Slides, Font, Paragraph, Drawing, and Editing 
INSERT: Tables, Illustrations, Links, Text, and Media Clips. 
DESIGN: Page Setup, Themes, Background. 
ANIMATIONS: Preview, Animations, Transition to this Slide 
SLIDE SHOW: Start Slide Show, Set Up, Monitors. 

REVIEW:  Proofing, Comments, Protect. 

VIEW: Presentation Views, Show/Hide, Zoom, Window, Macros 
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QUICK ACCESS TOOLBAR 

The quick access toolbar is a customizable toolbar that contains commands that you may want 
to use.  You can place the quick access toolbar above or below the ribbon.  To change the 
location of the quick access toolbar, click on the arrow at the end of the toolbar and click Show 
Below the Ribbon. 

 

 
MINI TOOLBAR 

A new feature in Office 2007 is the Mini Toolbar.  This is a floating toolbar that is displayed 
when you select text or right-click text.  It displays common formatting tools, such as Bold, 
Italics, Fonts, Font Size and Font Color. 
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NAVIGATION 

Navigation through the slides can be accomplished through the Slide Navigation menu on the left 
side of the screen.  Also, an outline appears from materials that have been entered in the 
presentation.  To access the outline, click the outline tab. 

 

 
SLIDE VIEWS 

Presentations can be viewed in a variety of manners.  On the View tab, the Presentation Views 
group allows you to view the slides as Normal, Slide Sorter, Notes Page, Slide Show, Slide 
Master, Handout Master, and Notes Master. 
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HOW TO MAKE NEW PRESENTATION 

 
You can start a new presentation from a blank slide, a template, existing presentations, or a Word 
outline.  To create a new presentation from a blank slide: 

 Click the Microsoft Office Button  
 Click New  
 Click Blank Presentation  

 

To create a new presentation from a template: 

 Click the Microsoft Office Button  
 Click New  
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 Click Installed Templates or Browse through Microsoft Office Online Templates  
 Click the template you choose  

 

To create a new presentation from an existing presentation: 

 Click the Microsoft Office Button  
 Click New  
 Click New from Existing  
 Browse to and click the presentation  

 

To create a new presentation from a Word outline: 

 Click the slide where you would like the outline to begin  
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 Click New Slide on the Home tab  
 Click Slides from Outline  
 Browse and click the Word Document that contains the outline  

 

 

SAVE A PRESENTATION 

 
When you save a presentation, you have two choices: Save or Save As. To save a document: 

 Click the Microsoft Office Button  
 Click Save  
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You may need to use the Save As feature when you need to save a presentation under a different 
name or to save it for earlier versions of PowerPoint.  Remember that older versions of 
PowerPoint will not be able to open PowerPoint 2007 presentation unless you save it as a 
PowerPoint 97-2003 Format. To use the Save As feature: 

 Click the Microsoft Office Button  
 Click Save As  
 Type in the name for the Presentation  
 In the Save as Type box, choose Excel 97-2003 Presentation  
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ADD SLIDES 

There are several choices when you want to add a new slide to the presentation: Office Themes, 
Duplicate Selected Slide, or Reuse Slides. 
 

To create a new slide from Office Themes: 

 Select the slide immediately BEFORE where you want the new slide  
 Click the New Slide button on the Home tab  
 Click the slide choice that fits your material  

 

 

 

 

 

 

 

 

 

 

 

To create a slide as a duplicate of a slide in the presentation: 

 Select the slide to duplicate  
 Click the New Slide button on the Home tab  
 Click Duplicate Selected Slides  
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To create a new slide from another presentation: 

 Select the slide immediately BEFORE where you want the new slide  
 Click the New Slide button on the Home tab  
 Click Reuse Slides  
 Click Browse  
 Click Browse File  
 Locate the slide show and click on the slide to import  

 

 

 

 

 



Chapter No 15: Microsoft power point 2007 

231 
 

 

THEMES 

 
Themes are design templates that can be applied to an entire presentation that allows for 
consistency throughout the presentation.  To add a theme to a presentation: 

 Click the Design tab  
 Choose one of the displayed Themes or click the Galleries button.  

 

To apply new colors to a theme: 

 Click the Colors drop down arrow  
 Choose a color set or click Create New Theme Colors  

 

To change the background style of a theme 
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 Click the Background Styles button on the Design tab  

 

 

ENTER TEXT 

 
To enter text: 

 Select the slide where you want the text  
 Click in a Textbox to add text  

 

To add a text box: 
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 Select the slide where you want to place the text box  
 On the Insert tab, click Text Box  
 Click on the slide and drag the cursor to expand the text box  
 Type in the text  

 

 

SELECT TEXT 

 
To select the text: 

 Highlight the text  

 

 

COPY AND PASTE 

 
To copy and paste data: 

 Select the item(s) that you wish to copy  
 On the Clipboard Group of the Home Tab, click Copy  
 Select the item(s) where you would like to copy the data  
 On the Clipboard Group of the Home Tab, click Paste  
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CUT AND PASTE 

 
To cut and paste data: 

 Select the item(s) that you wish to copy  
 On the Clipboard Group of the Home Tab, click Cut  
 Select the items(s) where you would like to copy the data  
 On the Clipboard Group of the Home Tab, click Paste  

 

 

UNDO AND REDO 

 
To undo or redo your most recent actions: 

 On the Quick Access Toolbar  
 Click Undo or Redo  
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SPELL CHECK 

 
To check the spelling in a presentation: 

 Click the Review tab  
 Click the Spelling button  

 

 

 

CHANGE FONT TYPEFACE AND SIZE 

 
To change the font typeface: 

 Click the arrow next to the font name and choose a font.   
 Remember that you can preview how the new font will look by highlighting the text, and 

hovering over the new font typeface.  
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To change the font size: 

 Click the arrow next to the font size and choose the appropriate size, or  
 Click the increase or decrease font size buttons.  

 

 

 

FONT STYLES AND EFFECTS 

 
Font styles are predefined formatting options that are used to emphasize text.  They include:  
Bold, Italic, and Underline.  To add these to text: 

 Select the text and click the Font Styles included on the Font group of the Home tab or  
 Select the text and right click to display the font tools  

 

 

CHANGE TEXT COLOR 
 

To change the text color: 

 Select the text and click the Colors button included on the Font Group of the Ribbon, or  
 Highlight the text and right click and choose the colors tool.   
 Select the color by clicking the down arrow next to the font color button.  
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WORDART 

 
WordArt are styles that can be applied to text to create a visual effect. To apply Word Art: 

 Select the text  
 Click the Insert tab  
 Click the WordArt button  
 Choose the WordArt  
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To modify the styles of WordArt 

 Select the WordArt  
 Click the Format tab for the Drawing Tools  
 Click the WordArt Fill button, the WordArt Outline button, or the Text Effects button  

 

 

CHANGE PARAGRAPH ALIGNMENT 

 
The paragraph alignment allows you to set how you want text to appear.  To change the 
alignment: 

 Click the Home Tab  
 Choose the appropriate button for alignment on the Paragraph Group.  

 Align Left:  the text is aligned with your left margin  
 Center:  The text is centered within your margins  
 Align Right:  Aligns text with the right margin  
 Justify:  Aligns text to both the left and right margins.  

 

 

INDENT PARAGRAPHS 
 

To indent paragraphs, you can do the following: 

 Click the Indent buttons to control the indent.   
 Click the Indent button repeated times to increase the size of the indent.  
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TEXT DIRECTION 
 

To change the text direction: 

 Select the text  
 Click the Text Direction button on the Home tab  
 Click the selection  

 

 

RESIZE A TEXTBOX 
 

To resize a textbox: 

 Click on the textbox  
 Click the corner of the box and drag the cursor to the desired size  
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BULLETED AND NUMBERED LISTS 

 
Bulleted lists have bullet points, numbered lists have numbers, and outline lists combine 
numbers and letters depending on the organization of the list. 
To add a list to existing text: 

 Select the text you wish to make a list  
 Click the Bulleted or Numbered Lists button  

 

To create a new list: 

 Place your cursor where you want the list in the document  
 Click the Bulleted or Numbered Lists button  
  Begin typing  

 

NESTED LISTS 

A nested list is list with several levels of indented text. To create a nested list: 

 Create your list following the directions above  
 Click the Increase or Decrease Indent button  

 

FORMATTING LISTS 
 

The bullet image and numbering format can be changed by using the Bullets or Numbering 
dialog box. 
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 Select the entire list to change all the bullets or numbers, or 
Place the cursor on one line within the list to change a single bullet.  

 Click the arrow next to the bulleted or numbered list and choose a bullet or numbering 
style.  

 

 

 

ADDING VIDEO 
 

Video clips can be added to the presentation.  To add a video clip: 

 Click the Movie button on the Insert tab  
 Choose Movie from File or Movie from Clip Organizer  

 

To edit the video options: 

 Click the movie icon  
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 Click the Format tab  

 

 

ADDING AUDIO 
 

Audio clips can be added to the presentation.  To add an audio clip: 

 Click the Audio button on the Insert tab  
 Choose Sound from File, Sound from Clip Organizer, Play CD Audio Track, or 

Record Sound  

 

To edit the audio options: 

 Click the audio icon  
 Click the Format tab  
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ADDING PICTURE 
 

To add a picture: 

 Click the Insert Tab  
 Click the Picture Button  
 Browse to the picture from your files  
 Click the name of the picture  
 Click insert  

 To move the graphic, click it and drag it to where you want it  
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ADDING CLIP ART 
 

To add Clip Art: 

 Click the Insert Tab  
 Click the Clip Art Button  
 Search for the clip art using the search Clip Art dialog box  

 

 Click the clip art  
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 To move the graphic, click it and drag it to where you want it  

 

EDITING PICTURES AND CLIP ART 

 
When you add a graphic to the presentation, an additional Tab appears on the Ribbon.  The 
Format Tab allows you to format the pictures and graphics.  This tab has four groups: 

Adjust:  Controls the picture brightness, contrast, and colors 
Picture Style:  Allows you to place a frame or border around the picture and add effects 
Arrange:  Controls the alignment and rotation of the picture 
Size:  Cropping and size of graphic 
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ADDING A SHAPE 
 

To add Shapes: 

 Click the Insert Tab  
 Click the Shapes Button  
 Click the shape you choose  

 

 Click the Slide  
 Drag the cursor to expand the Shape  

 

To format the shapes: 

 Click the Shape  



Chapter No 15: Microsoft power point 2007 

247 
 

 Click the Format tab  

 

 

ADDING SMARTART 
 

SmartArt is a feature in Office 2007 that allows you to choose from a variety of graphics, 
including flow charts, lists, cycles, and processes.  To add SmartArt: 

 Click the Insert Tab  
 Click the SmartArt Button  
 Click the SmartArt you choose  

 

 Click the SmartArt  
 Drag it to the desired location in the slide  
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CREATE A TABLE 

 
To create a table: 

 Place the cursor on the page where you want the new table  
 Click the Insert Tab of the Ribbon  
 Click the Tables Button on the Tables Group.  You can create a table one of four ways:  

 Highlight the number of row and columns  
 Click Insert Table and enter the number of rows and columns  
 Click the Draw Table, create your table by clicking and entering the rows and 

columns  
 Click Excel Spreadsheet and enter data  

 

 

ENTER DATA IN A TABLE 
 

Place the cursor in the cell where you wish to enter the information.  Begin typing. 
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MODIFY THE TABLE STRUCTURE AND FORMAT A 
TABLE 

 

To modify the structure of a table: 

 Click the table and notice that you have two new tabs on the Ribbon:  Design and 
Layout.  These pertain to the table design and layout.  

On the Design Tab, you can choose: 

 Table Style Options  
 Table Styles  
 Draw Borders  

 

To format a table, click the table and then click the Layout Tab on the Ribbon.  This Layout tab 
allows you to: 

 View Gridlines and Properties (from the Table Group)  
 Insert Rows and Columns (from the Rows & Columns Group)  
 Delete the Table, Rows and/or Columns (from the Rows & Columns Group)  
 Merge or Split Cells (from the Merge Group)  
 Increase and decrease cell size (Cell Size Group)  
 Align text within the cells and change text directions (Alignment Group)  
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HOW TO CREATE CHARTS? 

Charts allow you to present information contained in the worksheet in a graphic format. 
PowerPoint offers many types of charts including: Column, Line, Pie, Bar, Area, Scatter and 
more.  To view the charts available click the Insert Tab on the Ribbon. 

 

 
To create a chart: 

 Click the Insert tab on the ribbon  
 Click the type of Chart you want to create  
 Insert the Data and Labels  
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SLIDE TRANSITIONS 
 

Transitions are effects that are in place when you switch from one slide to the next.  To add slide 
transitions: 

 Select the slide that you want to transition  
 Click the Animations tab  
 Choose the appropriate animation or click the Transition dialog box  

 

To adjust slide transitions: 

 Add sound by clicking the arrow next to Transition Sound  

 

 Modify the transition speed by clicking the arrow next to Transition Speed  
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To apply the transition to all slides: 

 Click the Apply to All button on the Animations tab  

 

To select how to advance a slide: 

 Choose to Advance on Mouse Click, or  
 Automatically after a set number of seconds  

 

 

SLIDE ANIMATION 
 

Slide animation effects are predefined special effects that you can add to objects on a slide.   To 
apply an animation effect: 

 Select the object  
 Click the Animations tab on the Ribbon  
 Click Custom Animation  
 Click Add Effect  
 Choose the appropriate effect  
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ANIMATION PREVIEW 
 

To preview the animation on a slide: 

 Click the Preview button on the Animations tab  

 

 

SLIDE SHOW OPTIONS 
 

The Slide Show tab of the ribbon contains many options for the slide show.  These options 
include: 

 Preview the slide show from the beginning  
 Preview the slide show from the current slide  
 Set up Slide Show  
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SET UP SLIDE SHOW  

 
This option allows you to set preferences for how the slide show will be presented. The options 
include: 

 Whether the show will run automatically or will be presented by a speaker  
 The looping options  
 Narration options  
 Monitor resolutions  
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PRINT A PRESENTATION 

 
There are many options for printing a presentation.  They are: 

 Slides: These are slides that you would see if you were showing the presentation, one 
slide per page  

 Handouts: 1, 2, 3, 4, 6 or 9 per page, this option allows for more slides per page  
 Notes Page: This includes the slides and the speaker notes  
 Outline View: This will print the outline of the presentation  

To access the print options: 

 Click the Microsoft Office Button  
 Click Print  
 In the Print Dialog Box, click the arrow next to Print what  
 Choose the format and click OK to print  
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To print preview: 

 Click the Microsoft Office Button  
 Place the cursor over Print  
 Click Print Preview  
 Click the arrow next to Print What to change print options  
 To print from Print Preview, click Print  

 

To Exit Print Preview: 

 Click the Close Print Preview button  
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CHAPTER NO 16 

 

 MICROSOFT EXCEL 2007 
 
 
Microsoft Excel 2007 is an electronic spreadsheet software package that allows you to 
organize data in a tabular format, perform mathematical calculations, and analyze data. This 
software includes functions, formulas, and charts. It is commonly used in business, 
engineering, mathematics, and statistics.  
 

Microsoft Excel 2007 is the newest version of Microsoft Office's worksheet (spreadsheet) 
program. Technically a worksheet is a single document inside a workbook but we often use 
the terms worksheet, spreadsheet and workbook interchangeably. Worksheets contain 
numerical information presented in tabular row and column format with text that labels the 
data.  

It can also contain graphics and charts. Like Microsoft Word 2007, Excel 2007 takes 
advantage of a new, results-oriented user interface to make powerful productivity tools easily 
accessible. If you're worried about capacity, Excel 2007 now accommodates 1 million rows 
and 16,000 columns. 

GETTING START 

 

To start MS Excel click on the Start Menu on the bottom left corner of your 
desktop and select Start→ All Programs→ Microsoft Office →Microsoft 
Office excel 2007.  

 

SCREEN LAYOUT 

 
The MS Excel 2007 interface brings out all the functionality of the software using tabs rather 
than drop-down menus.  
 
The main work area is called a spreadsheet where you can communicate your data using 
functions, formulas, and charts.  
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The highlighted cell is called the active cell and is the current place where you can enter a 
value or a formula. We will describe the parts of the interface in the following sections.  
 

Getting started with Excel 2007 will notice that there are many features.  There are three 
features that you should remember as you work within Excel 2007:  

1. The Microsoft Office Button,  
2. The Quick Access Toolbar,  
3. The Ribbon.   

The function of these features will be more fully explored below. 
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OFFICE BUTTON 
  
The Office button (located at the top left of the MS Excel Window) is a drop-down menu of 
commands that you can use on MS Excel files. It includes creating a new file, opening an existing file, 
saving, and printing. A menu choice with a right pointing arrow expands to another menu of 
command choices.  
 
 

 

 

 

 

 

 

 

 

 

 

 

RIBBON 
 

The ribbon is the panel at the top portion of the document   It has seven tabs:  Home, Insert, 
Page Layouts, Formulas, Data, Review, and View.  Each tab is divided into groups.  The 
groups are logical collections of features designed to perform function that you will utilize in 
developing or editing your Excel spreadsheets.   
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Commonly utilized features are displayed on the Ribbon.  To view additional features within 
each group, click the arrow at the bottom right corner of each group. 

 

 

HOME: Clipboard, Fonts, Alignment, Number, Styles, Cells, Editing. 
INSERT: Tables, Illustrations, Links, Text, and Media Clips. 
PAGE 
LAYOUTS: 

Themes, Page Setup, Scale to Fit, Sheet Options, Arrange 

FORMULAS: Function Library, Defined Names, Formula Auditing, Calculation 
DATA: Start Slide Show, Set Up, Monitors. 

REVIEW Proofing, Comments, Protect. 

VIEW: Presentation Views, Show/Hide, Zoom, Window, Macros 
 

 

QUICK ACCESS TOOLBAR 

 
The Quick Access Toolbar is a customizable toolbar that contains commands that you may 
want to use.  You can place the quick access toolbar above or below the ribbon.  To change 
the location of the quick access toolbar, click on the arrow at the end of the toolbar and click 
Show below the Ribbon. 
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 MINI TOOLBAR 
 

A new feature in Office 2007 is the Mini Toolbar.  This is a floating toolbar that is displayed 
when you select text or right-click text.  It displays common formatting tools, such as Bold, 
Italics, Fonts, Font Size and Font Color. 
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HOW TO CREATE A WORKBOOK 

 

To create a new Workbook: 

 Click the Microsoft Office Toolbar  
 Click New  
 Choose Blank Document  

 

 

 

 

 

 

 

If you want to create a new document from a template, explore the templates and choose one 
that fits your needs. 
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SAVE A WORKBOOK 
 

When you save a workbook, you have two choices: Save or Save As. 
To save a document: 

 Click the Microsoft Office Button  
 Click Save  

 

 

You may need to use the Save As feature when you need to save a workbook under a 
different name or to save it for earlier versions of Excel.  Remember that older versions of 
Excel will not be able to open an Excel 2007 worksheet unless you save it as an Excel 97-
2003 Format. To use the Save As feature: 

 Click the Microsoft Office Button  
 Click Save As  
 Type in the name for the Workbook  
 In the Save as Type box, choose Excel 97-2003 Workbook  
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OPEN A WORKBOOK 
 

To open an existing workbook: 

 Click the Microsoft Office Button  
 Click Open  
 Browse to the workbook  
 Click the title of the workbook  
 Click Open  
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ENTERING DATA 
 

There are different ways to enter data in Excel:  in an active cell or in the formula bar. 
To enter data in an active cell: 

 Click in the cell where you want the data  
 Begin typing  

 

 
To enter data into the formula bar 

 Click the cell where you would like the data  
 Place the cursor in the Formula Bar  
 Type in the data  
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WHAT ARE SPREADSHEETS? 
  
A spreadsheet is a group of cells organized into columns and rows containing data.  
Cell References: Rows and Columns  
 
A Row is a set of cells in the horizontal direction. Each row is numbered where the top-most 
row is numbered as 1. You can change the height of a row by moving your mouse over the 
row line and dragging it to your desired height.  
 
 

 

  

 
 

A Cell is a single box that is the intersection of a column and row. Each cell is named 
according to its column label and row number, called a Cell Reference.  
 
For example, the highlighted cell shown below is named cell B3. The name box is located at 
the top left corner of the worksheet and displays the cell reference of the active cell.  
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WORKING WITH DATA 
 
You can enter text, numbers, Booleans, dates, times, and formulas into a cell.  
 
TEXT  
 
Text is any combination of numbers, spaces, and non-numeric characters. For example, Excel 
treats the following entries as text: 10AA109, 127AXY, 12-976, 208 4675. All text is left-
aligned in a cell by default.  
 
NUMBER  
 
A number can contain only the following characters: 0 1 2 3 4 5 6 7 8 9 + - ( ) /. All numbers 
are right-aligned in a cell by default. Excel ignores leading plus signs (+) and treats a single 
period as a decimal. You can use the following characters to format the number: , $ %., e.g. 
1,000, $13.25, and 57%. All other combinations of numbers and nonnumeric characters are 
treated as text.  
 
BOOLEAN  
 
The values TRUE and FALSE are special values called Boolean values. A Boolean 
expression in a formula will evaluate to one of these two values. Note that surrounding either 
TRUE or FALSE with quotes, e.g. “TRUE”, does NOT indicate a Boolean value, rather a text 
value.  
 
DATE AND TIME  
 
The way that a date or time is displayed on a worksheet depends on the format applied to the 
cell. All dates and times are right-aligned in a cell by default. A date may be a short date, e.g. 
11/27/2008, or a long date, e.g. Thursday, November 27, 2008. Excel only recognizes dates 
staring from January 1, 1900. Also, Excel treats dates as numbers where 1/1/1900 is the same 
as 1, 1/2/1900 is the same as 2, and so on.  
A time is formatted as hours, minutes, seconds, and AM/PM, e.g. 1:12:04 PM. Times are 
also numbers, where each time is a number between 0 and 1. For example, midnight is 0 and 
noon is 0.5, and 11:59:59 PM is 0.999988425925926. If Excel cannot recognize a date or 
time that you enter, then it is treated as text.  
 

FORMULA 
 
A formula is a mathematical expression that evaluates to a single value. It can be used to 
perform a useful calculation in a cell. You can construct a formula using any mix of the 
following components: constants, mathematical operators, cell references and ranges, and 
functions.  
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CONSTANTS  
 
A constant is a number or text value that does not change.  
 
MATHEMATICAL OPERATORS  
 
A mathematical operator specifies a calculation. Common operators are: + (add), - (subtract), * 
(multiplication), and / (division).  
 
CELL REFERENCES AND CELL RANGES  
 
A cell reference in a formula evaluates to the value contained with that cell. A range of cells 
can be specified using the colon:  symbol. A range can contain a row, a column, or a block of 
cells. As shown below, the syntax A1:C1, A1: A5, and B2:C5 specify ranges along a row, a 
column, and a block of cells, respectively.  
 

 
 
 
FUNCTIONS  
 
A function is a pre-defined formula in Excel that you can insert into your formula. Each 
function is specified by its name and input arguments and evaluates to a single value.  
 
CREATING FORMULAS  
 
To create a basic formula, use the following procedure:  

1) Select with your mouse the cell in which you would like to insert your formula, e.g. 
A1 in the figures below.  
2) All formulas must start with an = sign.  
3) After you type the = sign, type your syntactically correct formula.  
4) Click Enter when you are done.  

 
If you type your formula directly into the active cell then it will be simultaneously displayed 
in the Insert Function box. Alternatively, you may type your formula into the Insert Function 
box.  
 
After you press Enter, the cell will display the evaluated value of your formula and the Insert 
Function box will display the formula  
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CALCULATING WITH FUNCTIONS  
 
One or more functions may be specified in a formula to help calculate a desired final value in 
a cell. The most commonly used functions can be found under the AutoSum button, which 
looks like a summation symbol in mathematics and found on the Home tab under the Editing 
se. 
 

 

 

 

 

 

 
 
Consider the following table of student names and homework scores. The block of cells 
A1:D5 contain constant values (text and numbers).  
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To compute the SUM over the column of HW#1 scores in cell B7 perform the following:  
 

1. Click on the cell B7 to make it the active cell. 
2. Click the AutoSum button’s drop-down menu and choose Sum.  
3. Highlight cells B2 through B5 with your mouse (Excel will outline the cells in the 

chosen range). The formula shown in cell B7 will be =SUM (B2:B5), where the 
function called SUM is given the range B2:B5 is its input argument.  

4.  The cell B7 will display evaluated value (final answer) for the formula.  
 

 

 

 

The AutoSum button contains other commonly used as listed below:  
 
Sum: Add all the numeric values contained in the cells specified in the input argument. 
Average: Averages all the numeric values contained in the cells specified in the input 
argument.  
Min: Determines the smallest numeric value among all the cells specified in the input 
argument. 
Max: Determines the largest numeric value among all the cells specified in the input 
argument.  
Count: Counts how many cells contain numeric values in the input argument. 
 
 
 
 

The IF function  
 
The IF function is a useful function in that it allows you to place one of two values in a cell 
based on a decision.  
 
For example, if you would like to place either the text value “YES” or value “NO” in E2 
based on the decision whether Jane Doe has the highest HW#1 score, then you can enter the 
formula: 
 

=IF (B2 = B10, "YES", "NO") 
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The IF function has up to three comma separated arguments: 
 
 

IF( <Boolean expression>, 
 

A Boolean expression that evaluates to either 
TRUE or FALSE. You can use relational 

operators (<, >, =, <=, >=) and the Boolean 
functions AND, OR, and NOT to build your 

Boolean expression. 
 
 

<Expression when TRUE>, 

If the first argument evaluates to TRUE, then 
this expression is evaluated and the final 

value will display in the cell. This expression 
can evaluate to any value. 

 

<Expression when FALSE>) 

 
If the first argument evaluates to FALSE, 

then this expression is evaluated instead. This 
expression can also evaluate to any value. 

This argument is optional. 
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CUT , COPY & PASTE 
 
You can copy (or cut) the contents of a cell and then paste the contents to a different cell.  
 

 Select text which you want to copy by using mouse or key board (by shift and arrow 
keys) 

 
 

o Press CTRL+C (Depress the CTRL key while pressing the “C”) from the 
keyboard, for copy and CTRL+X for cut. 

 
OR 

 
o You can select a shortcut button on ribbon a copy. Where you want to paste, 

you have to take cursor by using key board arrow keys Or by mouse click. 
 

o Press CTRL+V (Depress the CTRL key while pressing the “V”) from the 
keyboard, for paste the text. Which you already copy. 

 
OR 

 
o You can select a shortcut button on ribbon as “Paste”. 

 

 

 

 

 

 

 

 

 

 

COPY/PASTE WITH AUTOFILL  
 
To copy the contents of a cell to neighboring cells (along a row, column, or block of cells) 
use the AutoFill feature, which is the square located at the bottom right corner of the active 
cell.  
 



Chapter No 16: Microsoft Excel 2007 

272 
 

 
 
 
For example: 
 
To copy the number 22 in cell A1 (see left figure) to the cells in A2:A4, first click on the cell 
to activate it. Move your cursor over the AutoFill square so that your mouse pointer turns into 
a thin cross. Click down on the square with the left mouse button and drag your mouse to A4 
Release you’re the left mouse button and you will see the result of the copy/paste in A2:A4.  
 
 

 
 
 
 
RELATIVE ADDRESSING  
 
When you copy/paste formulas, Excel will preserve the structure of the formula but may 
change the cell references in the formula according to the direction in which the copy/paste 
occurs, called Relative Addressing. 
 
For example,  
 
If we copy the contents of cell B7 (=SUM (B2:B5)) and paste it across the row to cell D7l, 
then cell D7 will contain the updated formula =SUM(D2:D5), which is the total of all the 
HW#3 scores (see the left figure). Using the Auto fill feature again across each row, we can 
copy/paste the formulas at the bottom of the table to compute values for HW#2 and HW#3  
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ABSOLUTE ADDRESSING  
 
We can copy/paste the formula in cell E2 to down the column to E5 to determine whether or 
not each student has the highest HW#1 score. If copy/paste the formula  
 

=IF (B2 = B10, "YES", "NO") 
 
in cell E2 down the column, then the resulting formula in cell E5 will be 
 

=IF (B5 = B13, "YES", "NO") 
 
This formula is INCORRECT since we would like to compare the contents of cell B5 with 
the maximum over all HW#1 scores in cell B10.  
 
The change of the cell reference change from B2 to B5 due to Relative Addressing is 
desired, but the change from B10 to B12 is not. 
 
 We can indicate that a cell reference in a formula must not change in a copy/paste by placing 
the $ symbol next to the row and column of the cell reference, called Absolute Addressing. 
Thus, the formula in cell E2 should be re-written as 

 
=IF (B2 = $B$10, "YES", "NO") 

 
After this formula is copy/paste down the column to cell E5, then cell E5 will contain the 
formula  
 

=IF (B5 = $B$10, "YES", "NO") 
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TEXT FORMATTING 
 
 
Format text values using the commands in the Font Section such as the font type, font size, 
color, bold, italics, etc. Use the All Borders button to change the border attributes of blocks of 
cells.  
 

 

 

  

 

 

Position values in a cell both horizontally and vertically. If the text you type in a cell is longer 
than the width of the cell use the Wrap Text button to fit the text by adjusting the size and 
shape of the cell. If you would like to merge text in adjacent cells, then highlight all the cells 
and then press the Merge and Center button.  
 

 

 

 

 

 

 
NUMBER FORMATTING  
 
Format number values as you would like them to be displayed using the Number section. 
You can determine the number of digits to be displayed after the decimal place as well.  
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SORTING  
 
Sort a table of data by first highlighting all the cells in the table (including any headings) and 
then select Sort & Filter from the Editing section and choose the order to sort the table. We 
sort the following table by Name in the following example.  
 

 

 

CELL FORMATTING  
 
Excel provides pre-defined table formatting using the Styles section. Highlight your table of 
data and then use the Format as Table drop-down menu to choose a table format for the 
table heading and entries (see the top table, where the heading is colored black the data in 
blue). Change the look of groups of cells with the Cell Styles drop-down menu (see bottom 
table, where the cells are colored in light red).  
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Insert or delete groups of cells or an entire row or column using the Cells section.  

 

 

 

 

 

WHAT ARE CHARTS  
 

Charts allow you to present information contained in the worksheet in a graphic format. 
Excel offers many types of charts including: Column, Line, Pie, Bar, Area, Scatter and more.  
To view the charts available click the Insert Tab on the Ribbon. 

HOW TO CREATE A CHART 
 

To create a chart: 

 Select the cells that contain the data you want to use in the chart  
 Click the Insert tab on the Ribbon  
 Click the type of Chart you want to create  
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 Click the type of Chart you want to create  

 

MODIFY A CHART 
 

Once you have created a chart you can do several things to modify the chart.   

To move the chart: 

 Click the Chart and Drag it another location on the same worksheet, or  
 Click the Move Chart button on the Design tab  
 Choose the desired location (either a new sheet or a current sheet in the workbook)  

 

To change the data included in the chart: 

 Click the Chart  
 Click the Select Data button on the Design tab  



Chapter No 16: Microsoft Excel 2007 

280 
 

 

To reverse which data are displayed in the rows and columns: 

 Click the Chart  
 Click the Switch Row/Column button on the Design tab  

 

To modify the labels and titles: 

 Click the Chart  
 On the Layout tab, click the Chart Title or the Data Labels button  
 Change the Title and click Enter  
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CHART TOOLS 

 
The Chart Tools appear on the Ribbon when you click on the chart.  The tools are located on 
three tabs:  Design, Layout, and Format.   
 
Within the Design tab you can control the chart type, layout, styles, and location. 

 

 
Within the Layout tab you can control inserting pictures, shapes and text boxes, labels, axes, 
background, and analysis. 

 

Within the Format tab you can modify shape styles, word styles and size of the chart. 

 

COPY A CHART TO WORD 

 Select the chart  
 Click Copy on the Home tab  
 Go to the Word document where you want the chart located  
 Click Paste on the Home tab  



Chapter No 16: Microsoft Excel 2007 

282 
 

 


	Ch no 1
	Ch No 2
	Ch No 3
	Ch No 4
	Ch No 5
	Ch No 6
	Ch No 7
	Ch No 8
	Ch No 9
	ch no 10
	ch no 11
	ch no 12
	ch no 13
	ch no 14
	ch no 15
	ch no 16

